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This is a step by step guide to help in the process workflow of Design Branch 
project creation and development, culminating in the preparation of contract 
advertisement documents and project document archivals.  Every attempt has 
been made to provide guidance to the engineer and/or technician for the 
processes involved in execution of each project.  It is understood that many of 
the processes described herein .0are generic. Different processes are required 
for various disciplines in the project development workflow. Therefore these 
variants are described in varying detail as needed.  
 
The Process steps will be general in nature in order to alert the user of which 
items need to be accomplished in the order necessary to complete the process in 
a comprehensive manner. The workflows for specific procedures such as Project 
Wise or InRoads model development for example will be detailed in separate 
workflows in Appendix A.  No attempt has been made to identify PDT member 
duties and responsibilities. For the purpose of this document, PDT processes do 
not detail workflows for the technical production of project design documents and 
neither does this document pretend to detail PDT processes. 
 
There are also included in this set of workflows and procedures subjects such as 
design document layout, presentation, and design scale in order to improve the 
presentation quality of the design product. While it is true that our work products 
are developed and completed in a digital format, printed documents are the final 
product format for the sighting and construction of the physical project features.  
In other words, the presentation quality and professional appearance of our 
project design documents should be of a high caliber. Inattention to design 
document quality attracts negative and critical response. 
 
 

Project Development Process Steps 
 
Step 1.  Project Initiation steps 

 Perform a data search for existing related project information such as: 
o Engineering Documentation Report (EDR) 
o Detail Design Report (DDR) 
o Geotechnical Data 
o Hydraulic and Hydrological data/criteria required for project design 
o Existing Surveys of the geographic area of the project site location 

 (Survey information should be detailed enough to achieve a 
comprehensive project design) 

 Review and understand the A/E/C CADD Standards and include the 
compliance effort when planning for the execution of the design and 
creation of the design files. 
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 Identify and prepare project scope 
 

Step 2.  Setup Process 
 Indentify project design members who will be the production team.  
 Identify and assign roles and responsibilities for each team member. 
 Determine generic title and decide on project abbreviation to use in 

naming project design files. 
 Create new or utilize existing project description consisting of 6 characters 

which will be used for all design file names throughout the project. 
 Develop a rough-draft index outline that includes all disciplines. This focus 

on project document content will force members to identify the level of 
effort as related to the number of sheet required. Careful consideration of 
this effort level will result in a realistic estimate of man-hour requirements 
and personnel schedule assignments.     

 Review the Standards compliance requirements for naming sheet and 
model files for each discipline.   

 
 
Step 3.  Project Wise (PW) Engineering Documentation Management 
System (EDMS) - Project Data Creation Process 

 The Project Technical Lead or lead engineer shall provide to the Project 
Wise Administrator the essential project information needed to create the 
project folders, disciplines included in the project execution, and team 
members that will be producing drawings for the project. 

 Submit information to one of the PW Team Administrators (Roger Porzig 
@ 232-1189, Troy Weber  @232-1994, or Pete Kendrick @ 232-1912) 
and request the project be created in the Project Wise Document 
Management System. 

 The PW Administrator Team creates workspace configurations for all 
folders and subfolders for the project. The emboldened text below 
indicates a suggested folder naming scheme.   

o Project Files -  
o Discipline Name Folder, (i.e. Civil) – Sheet file folder for each 

discipline’s subfolder.  
o Project Data Files – files for calculations, project documents. 
o InRoads – InRoads files for a subfolder under the Civil and 

Geotechnical disciplines’ folders only. 
o Model – model files related to discipline. 
o Working – files for preparation to develop work. 

 The workspace configurations are assigned to a previously created set of 
folders named like those above. The folders are created for each 
discipline and are set up for each project by the PW project admin team. 
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 The work space contains configured paths to resources such as seed 
files, cell libraries; InRoads configuration files, etc. (see the Workspace 
description in Appendix A). 

 The General discipline folder copied from the SAJ_EN Workspace folder 
in Project Wise, consists of resources such as project border/title block, 
project index template, and cover sheet. 

 Project Wise document names should be consistent in form throughout 
the project.    

o PW formats should be used to simplify the project maintenance 
process.  Each PW file is assigned a database record.  Each record 
contains a Document Name a Description, and a File Name.  These 
three fields can be used to populate the Index sheet information.  
Management of reference files and sheet files can be made easier 
if the following format is used. 
 Model files: 

 Document Name: Use the sheet feature name (Plan, 
Detail, Section title name when possible. 

 Description: Use to define the where the reference will 
be used in sheet files. 

 File Name: Use the AEC Standard Model File Name. 
 Sheet Files: 

 Document Name: Sheet drawing number (C-102) 
 Description: Index Sheet Description 
 File Name: Use the AEC Standard sheet file name. 

o Sheet file Document names and Description fields can be exported 
to an Excel file and imported to the index file and avoid the tedium 
of retyping all file information into the index sheet. 

 All documents related to the project should be place in the Project Wise 
project folder. 

 
 
Step 4.  Project Wise (PW) Sheet Size Selection Process 

 The default size sheet for all projects is ANSI D “34”x22” 
 The sheet size ANSI E (44”x34”) is appropriate for projects where the 

scale consideration encompassing extremely large geographic project 
area. 

 Remove unneeded template files from the general folder that are sizes 
other than what are needed for the project.onec the project sheet size is 
determined. 

 
Step 5.  Revise Project DGN Templates 

 Open the Project Wise project directory and select the General Discipline 
folder.  
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 Rename the cover, border and index files to the project’s abbreviated title 
and standard file names. Note – See AEC Standard for electronic design 
file naming guidance. The cover, abbreviations and symbols, Index,  
location and vicinity map files are all sheet files and should be named as 
sheet files. 

 Determine the P2 number assigned to the project. This number will be a 
prefix for all sheet files for the project. 

 
 
 
 
Step 6.  Project Design Preparation Procedure 

 Begin project design development 
o First, determine the number of sheets based on scales used to 

convey information for plans, sections, elevations, details, etc. 
o Next refer to the rough index with preliminary sheets for each 

discipline. This is a good method of planning for the sheet and 
sheet contents in a plan document set.  As you think through the 
sheets needed, attention will be focused on the plot scale of 
drawings, sheets needed to show all cross sections, etc. As earlier 
stated, design document preparation time can be associated to the 
effort involved in preparing each sheet needed in the plan set.  

 At this step the various disciplines needed to produce the design project, 
the discipline sub-type files, i.e., Electrical discipline and Power Plan, and 
all associated model design files that will be needed should be 
determined.  A suggested method is to identify the various sheets in each 
discipline and that should focus on the design models that will be 
referenced to the sheet files. Each design model file will be developed as 
individual design files. 

 
 
Step 7.  Create Design Files  

 From the list of design models defined, create a new design file for each 
model file needed.   

o In the Project Wise environment, create and name all new dgn files. 
o Log-in to CadConform and Brand each file to the correct model or 

sheet type.  This process should be done for each discipline in the 
Project Wise project area.  Each discipline will have there discipline 
listed under the project title. 

 Create the model design files assigning the appropriate model type. For 
example, the electrical discipline’s member(s) will develop the design 
models for the electrical site plan, power plan, detail designs, schedules, 
lighting plan, etc.  
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o The standard workspace configuration in Project Wise has preset 
configuration definitions for each seed files that match each 
disciplines requirements.  See the Jacksonville District Workspace 
description in Appendix B. 
 Model seed files for all disciplines use 3D seed files.  

 Create the new sheet files that will contain the referenced models. 
o The standard workspace set up in Project Wise has preset 

configurations for each seed files that match each disciplines 
requirements.  
 Vertical designs such as Architectural and Structural use are 

configured to use the vertical seed DGN which are 2D seed 
files. 

 Horizontal design such as Civil and Geotechnical use 
horizontal seed file which are 3D seed files.  

 
 

Step 7.  Prepare Sheet files (Build sheet composite files) 
 The step includes the reference of the border and design model files (plan, 

detail, elevation, section) to sheet files. 
 Referenced imagery (photography) requires the adherence to Raster 

Reference Procedures.  
o See the Reference File Procedure Workflow for details. 

 
 
Step 8.  Drawing Design Presentation and Layout   

 Drawing preparation presentation is described in the Drawing 
Presentation Checklist. This includes technical aspects such as scale 
choice, text heights, layout, and presentation quality standards and format 
requirements. 

 
 
Step 9.  Project Compliance Checking 

 The design team-lead and members must schedule and perform project 
standards compliance checks which are due at each quality review 
milestone.  See the CADconform File Checking workflow in Appendix A. 

 
o Prepare the standard compliance reports using CadConform®. 
o Make corrections required for compliance. 
o Produce compliance reports to submit during quality review. 

 Submit written justification for compliance deviations with report. 
 
 
Step 10.  Plotting   
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 Procedures for Microstation® Batch Plotting and IPLOT Batch Plotting 
including the, PDF Contract Document Set. See the Plotting with 
Microstation and IPLOT workflow for details. 

 
 
Step 11.  Contract Document PDF Preparation 

 Perform project design File Clean up procedures. 
o Eliminate all graphics existing outside of Sheet borders of 

boundaries of Model files. This provides a professional appearance 
for others, such as the construction contractor, who later will 
receive the design files from which to prepare the as-constructed 
files. 

 Use the printing methods referred to in Step 10, plot the contract set to a 
single PDF file named for the project for advertisement. 

 
Step 12.  Supplemental Drawings 

 Follow prescribed amendment and modification procedures: 
o Minor revisions to construction documents do not normally entail 

replacement of existing design documents.  
o Major revisions normally require superseding of the original drawings 

and introduction of revised “sheets”. 
 This would require creating a copy of the original drawing to a 

superseded folder in Project Wise.  
 The original designs would then be revised to meet the needed 

changes for the design contract amendment or modification. 
 Files/folders in Project Wise should be labeled in such a way as 

to identify the amendment or modification number. 
 In addition, the Admin team will change permissions for the 

superseded folders/files so that no changes can be made.  
 
 
 
 
 
Step 13.  Project Close Out 

 Achieve Project “As Constructed Design Files” and ASBUILTS in Project 
Wise. 
o As constructed design files will be archived in the Project Wise project 

folder area. 
o As-built files will be archived in the Project Wise As-Built Folder area.   

 A new folder will be created for each as-built document set to be 
archived.  
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Description: 
Project Wise® is the required engineering document management system for all 
project development. Users are also required to comply with the A/E/C CADD 
Standards in the preparation of project design files.  Project Wise® has the 
functionality to set configurations and automate many process steps making the 
production of the design documents much faster with less preparation and 
decision making on the part of the project team member.  This setting of 
configuration variables to automate workflows is known as a workspace.  The 
Jacksonville District Design Branch has developed a workspace that provides 
this automated process. It has been developed within the Project Wise® Admin 
environment using the proprietary Project Wise® paths and variables.  The 
process is described in detail below. 
 
Workspace definitions:  
 
Variables:  Variables are named terms that are predefined to perform particular 
functions in Microstation® environments.  For example MS_CELLLIST is a 
standard variable that the user, or a workspace can define as needed.  See the 
variable definition below. 
 
Values:   Actions or commands that are assigned to variables. If the variable 
‘MS_CELLLIST’ the cell path is set to a value of ‘x:\project\dgn\*.* ‘ then each 
time the user request to open a cell library, Microstation will search or show a list 
of libraries in the x:\project\dgn\ directory. 
 
Workspace:   A collection of variables and associated values, macros and 
defined paths that automate many design functions for the user and standardize 
workflows and processes.  
 
Workspace Configuration Blocks:  Workspace variables assigned through 
Project Wise® and saved as a named group of variables to attach to a Project 
Wise folder. 
 
Macro:  A command or set of commands that performs complex functions but 
automates the functions by invoking the commands through a single key stroke, 
like a function key, or perhaps may be imbedded in some other function.   
 
Standard Directories Project Wise: Folders and subfolders that have been 
predefined to establish a base for project folder set up routines. 
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Workspace Properties:   The assignment of groups of variables, macros, and 
automated functions to a particular set of discipline folders in the project 
directory.   
 
Workspace Folder Assignment:  The assignment of a discipline’s workspace 
properties to a folder or group of folders to achieve the workspace process goals. 
 
1. A workspace is an organized system that automates many of the design 

processes used in project design development.   
• The Jacksonville District Design Branch has established such a workspace 

for its users for project execution of designs.  This is accomplished through 
the utilization of a standardized Project Wise Folder organization.  Specific 
Workspace discipline definitions are attached or assigned to a folder.   

o Any design file created or opened from a workspace folder will be 
subject to the workspaces discipline functionality.  For example, a 
project that has a folder named Structures and a subfolder named 
Models will have two different sets of workspace assignments made.  
First, the Structures folder will have the Structural discipline’s sheet file 
settings assigned.  

• Sheet file workspace assignments initiate variables that call a 2D seed 
file if creating a new file, Sheet file Levels that will show up in the level 
manager of that design file if created or if an existing file residing in that folder 
is opened by the user.    

• The Models folder assign variables that calls all of the levels for the 
Structural discipline, set a 3D seed file from which to create model design 
files.  There are other named folders such as the Working folder or Inroads 
folder.  In these cases they are both considered folder that contain Model type 
design files and therefore would have the model type workspace assignments 
made.  Examples of how the Project Wise properties dialog is shown below.    

• The Project folder properties dialog on the 
left has the Workspace Tab selected.  
Notice the Discipline and User items.  The 
Discipline item has a configuration block that 
Sets a number of variables such as attaching 
the  text and dimension DGN Libraries or 

Dgnlibs that provide those styles for the 
user.  

o Other variables include levels, 
line styles, cell library paths, and 
seed file assignments,  line 

styles, etc.  The User configuration 
blocks provide items such as starting 
design file history, assignment of a 

function key menu with macros included for automated functions. 

Workspace 
TAB 

Discipline  
Workspace  
Assignment 

User 
Workspace  
Assignments 
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o The structural sheet file configuration block is also assigned because 
the particular folder selected is the structures folder which is the folder 
designated for sheet files.  If the folder was the InRoads, Models, or 
Working folder the Structures sheet file configuration block  

would not be assigned to the user workspace item.  The properties dialog below 
shows the workspace as it is assigned to the Models folder. 
 

o This is the Model folder 
properties dialog.  Notice that 
the assignments are the same 
with the exception that the 
Structures Sheet configuration 
block is not assigned to this 
folder.  All other configuration 
blocks are the same as the 
sheet file folder.  All Structures 
discipline model type levels will 
be shown in any design file 
opened or created from this 
folder. The standard dimension 
and text styles will be provided 
as well as the standard line 
types, cell library paths, and 
model seed file for the 

structures discipline. 
 
 
The Project Wise® Dialog to the 
left show the Plumbing Sheet 
file folder highlighted and the 
Properties dialog for that folder 
is shown bleow. Notice the 
various configuration blocks 
which are assigned.  
Remember this folder is named 
Plumbing so it is a Sheet file 
folder and therefore the 
workspace set up a sheet file 
configuration. 
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• The workspace is configured in a like manor for each folder in each project 

differing only with disciplines.  The team members should understand that the 
workspace can only be effective if the workspace is assigned by the Admin 
Team and that each folder is managed in such a way to separate sheet file 
folders from model type folders as shown in the examples above.  

 
2.  Existing Project Workspace Assignments 
 
Design project leaders should contact the CADD Coordinator to have the 
workspace assignment made to the current projects that are under design.  
Some file maintenance may be required. For example, if sheet files and model 
files are mixed in the same folder, the workspace will not work properly.  The 
sheet files must be segregated by discipline residing in a folder designated 
specifically for that disciplines sheet files. 
 
3.  New Project Workspace Assignments 
 
Design project leaders beginning design on new projects should contact the 
CADD Coordinator to create the project folder and subfolder with the workspace 
assignments already created.  This will be a very simple process that will only 
take a few minutes. 
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Project Wise Document Management System (PWDMS) 
Project Wise is the mandated document management system for management 
and control of engineering records or files. 
Definitions: 

Records: Engineering documents prepared to accomplish repair, 
maintenance, or construction of project features included in these documents are 
the planning, design analysis, plans and specifications, engineering 
documentation, and archival documents. 

Administrator(s): Project Wise administrators who manage and support 
the project design teams in the development of projects. 
  Folders: Project Wise File folders in which specific types of documents 
are filed. 

Model Type: The discrimination within a discipline of design categories. 
For example Civil Site work or Civil Navigation work.  
 Sheet Files: A DGN file type that is a “container” for a border/titleblock 
file, design models files.  Dimensioning, notes and other annotations are placed 
in the sheet files rather than the model files. 
 Model Files: A DGN file type that contains the graphic design that will be 
referenced to the sheet file. 
 Workspace:  Project Wise configurations preset to Project Folders that 
control the assignment of Microstation actions and variables set to each 
discipline and discipline model type.  
 DGNLIB: A DGN file that contains various settings such as levels for a 
particular discipline, dimension style settings, or text style settings.  When 
applied in the workspace, these settings populate the active design file with the 
DGNLIB settings.  SAJ uses a different DGNLIB for each discipline and a 
separate DGNLIB in each discipline for model files and sheet files. 

Model Type: The discrimination within a discipline of design categories. 
For example Civil Site work or Civil Navigation work.  
  
Commencing Project Design Preparation 
The Project Engineer assigned to the Project will contact the Project Wise 
Administrator to request the creation of the project folders needed to prepare the 
project including all disciplines involved in the project team.  The request should 
include the following information. 

1. Project Name 
2. Project P2 number 
3. Discipline included 
4. List of team members (for assignment of folder/file access) 
5. Design sheet size to be used  (ANSI D or ANSI E) 
6. Special Requests for menu items or additions to workspace 

configurations. 
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Folder Naming Conventions 

1. Administrators normally setup the initial Folders when creating the 
project for the project lead or PE. The team leaders do have 
permissions to create folders, however some guidelines are necessary 
in the naming convention. See the guidelines shown below.  These 
folders will be setup by the PWDMS administrator.  

• <Project Name>  (project parent folder) 
o <Discipline Name> (a folder for each discipline) 

• Data Files (non-design files) 
• Model Files (design model files) 
• InRoads (only in civil, geotechnical, and survey 

disciplines) 
• Working Files (general development files not 

included in the final design documents)  
2.  The specific names of the folders are not as important as the controlled 
content of the files in the folders. In other words sheet files and model files 
cannot reside in the same folder. Discipline-named folders must contain 
sheet files only, and the Model Files folders must contain model files only.  
3.  Files in the Model Files folder should be segregated into model types 
as described below in the Project Documents paragraph 1.b. 
4.  The Corps of Engineers Project Wise Administration Team is currently 
developing a Project-Wise Collaboration Model (PCM) that will require a 
more defined system to be implemented at a future date, as yet unknown.  

 
Project Documents 
 Project Documents include but are not limited to: 

1. Project design files including: 
• Sheet files   

o Cover sheets 
o Index sheets listing all design documents in the plan 

set. 
o Individual sheet files containing annotation text, scales, 

sheet title, coordinate tick marks and labels, and north 
arrow. (Sheet files reference design model files, 
border/title block files, and imagery to the sheet file.) 

• Model files: 
o Each discipline includes definitions for various 

categories or model types, for example the electrical 
discipline contains the following model types: 

1. Lighting Plan 
2. Power Plan 
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3. Special Systems Plan 
4. Grounding Systems Plan 
5. Electrical Utilities Plan 
6. Exterior Communications Systems Plan 
7. Airfield Lighting Plan 
8. Details 
9. Riser One-line Diagrams 
 

o Each discipline contains its own list of model types.  
The AEC CADD Standard Appendix A contains the 
model type definitions for all disciplines. 

o Each folder is assigned either sheet file or model file 
workspace properties attributes according to discipline. 

o The PWDMS workspace properties attributes are a 
listing of Microstation/Project Wise configuration 
variables that assign file resources and file path 
definitions to project  resource folders. If the workspace 
assignment is made to the electrical discipline sheet file 
folder example above in paragraph 1.a.  The 
configuration variables would assign a 2D seed file, 
standard text styles, dimension styles,  line styles, and 
electrical sheet file levels with graphic attribute 
assignments.  If the folder was the Model Files folder 
as shown in paragraph 1.b., the assigned workspace 
would set a 3D model seed assignment, attach the text 
and dimension styles library file, attach all of the 
electrical disciplines levels with graphic attribute 
assignments.  

o Folder discrimination must be made between sheet and 
model files in each discipline for the PWDMS 
workspace to be effective. 

2. Images used to add visual orientation to project design file 
presentations.  The General discipline folder contains an Imagery 
folder to contain all images for the project. 

• Images are more commonly aerial photos of project sites 
• Site visit photos 
• Scanned images of previous designs for informational purposes 

3. PDF files of project design files used for construction contract 
advertisement. 

4. InRoads development model, (InRoads models), files. These files are 
special files used to produce geographic earth models for project 
development. 
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Project Reports used in evaluating, analyzing, or documenting the project 
design. (see the list of report file type described in the Archiving  
 
Engineering Project Documents paragraph 2 below). 
5. Specifications and government cost estimates (special security 

considerations are applied to cost estimates).  
• Specifications and government cost estimates are archived in 

the project folder after the project is completed. There is not 
associative provisions in Project Wise to accommodate the 
development of the Specifications and Cost estimating 
programs. 

 
Archiving Engineering Project Documents  
1. In addition to in-house design files, other organization’s project files 

that must be managed and controlled by the PWDMS include:  
• Partnering Organization Project Documents  

o State agencies  
o AE submittals 
o Corps District design partners 

2. Types of documents that are included as archival documents are: 
• Amendments and Modification documents 

o Shop drawings 
o Amended design files 

• Construction Documents: 
o RFI communications 
o EDC documents 
o As-Built documents 

• Other archive documents include: 
o Specifications 
o Engineering Design Analysis 
o Design Documentation Reports 
o Detailed Design Reports (DDRs) 
o General Reevaluation Reports (GRRs) 
o Cost Estimates  
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Capturing metadata from Project Wise for import to an Excel Spreadsheet 
 

1. Highlight the desired design file data you would like imported to spreadsheet 
i.e. <ctrl>+a to select an entire discipline of sheet files 
 

2. Right click in the highlighted area and select Copy List To  Clipboard Tab 
Separated 

 
3. Paste into an open Excel spreadsheet.  

 
4. Edit exported text as desired to fit the format for the Index to Drawings. 
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Step 1  Preliminary preparation for design project workflow.   
 

• Select Resources from the Project Wise Saj EN Workspace to 
prepare for drawing development.  There are various resources 
available for the user.  These include, Standard Seed files, Cell Libraries, 
Borders and Companion files, Inroads INI files (Inroads Preferences and 
Geometry Styles).  It is important to move all the needed resources to your 
project within in Project Wise. This will require advance planning to 
determine the kinds of design files, which will be created in the project 
workflow. 

 
• CAD Conform and the AEC Standard. Cadconform maintains a 

connection to the AEC CADD Standard.  The Cad Conform application is 
a duel purpose product, (a) it manages the Standard, and (b) it is a 
drafting/design tool for the user enabling compliance with the standards 
while generating the project design elements through selection of menu 
options and placing design elements in the project design file. 

 
• Model Files Types and File Names. There are a few rules to follow in 

using CADconform and working within the AEC CADD Standard 
Framework. 

o Model type files are DGN files that focus specific elements of the 
project. For example, a set of civil works channel cross sections are 
required to be in a DGN file containing only cross sections. This is 
true in all disciplines. CAD Conform is configured in such a way that 
only menus containing items pertaining to the specific model type 
you have chosen are available.  These files will be referenced to 
sheet files as well as the border/title block to complete the drawing 
set. 
 

o CADconform does not control the file naming convention.  The 
file naming procedure is defined in the AEC CAD Standards. Corps 
team members whether in-house District members, AE firms, or 
Brokering Districts must use this naming format for model and 
sheet files.  

 
Step 2.  Executing the Cad Conform Program. On your desktop you should 
initiate starting a drawing by initializing the Icon titled CAD Microstation XM.  You 
should see Microstation XM start. 
   

• Once Microstation starts, the Project Wise Login Dialog should appear.  It 
is important that you login to this dialog.  If you are in the Project Wise 
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Explorer and browse to a DGN file in your project and double click to open 
the file.   

 

 
 
Login to Project Wise 
 
 

 
• Project Wise and Open File 

Dialog. When the Project Wise 
Login is successful, you will be 
prompted to open a file (DGN) 
the dialog presented will be a 
Project Wise open file dialog. 
Select the project, and file you 
whish to checkout and edit. 

 
• After the file opens select 

CADconform login. 
 
 

 
 

• In the CADconform Server Login Dialogue enter the user login and 
password Select Data Source type of discipline. 
o The user name field will require to you to type the discipline name 

to which your design work is defined.  This requires the discipline 
name to be typed in lowercase with no abbreviations. For example, 
civil, electrical, structural, mechanical, or architectural. 

o Pass word for all disciplines is “saj”. 
o When the discipline is entered the dialog will show the discipline in 

the Data Source field at the bottom of the login dialog.  
• The discipline log-in will then open a drafting menu only if the file 

opened was created and previously branded by CADconform as that 
discipline and model type.  If not previously branded to discipline and 
model you will be prompted to do so before a CADconform draft 
menu/icon dialog will be displayed.  
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• If the file has not been previously defined in CADconform by branding 
the discipline/model type, the Feature Table Manager dialog will 
display with a listing of the available model types.   

 
 

• In the Feature Table Manager select the type of file sheet/model file, 
i.e. sheet_file brings up civil sheet file.  After the type of file is selected 
click brand and then open, this will then brand the file type. 
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• Step 4.  Set Up the Drawing Scale.   The Drawing Scale dialog allows 
the user to define the active scale of the current design file / model. 
The Drawing Scale allows the user to define text sizes only once in a 
text feature, and then apply a different drawing scale to get various text 
scales. The Drawing Scale is effectively a global scale multiplier, so it 
can only really be used if a uniform scale multiplier can be applied to 
text features in the context of one design file / model.  

 

 
 
Set the Drawing Scale.  The drawing scale can be set manually and is only 
applied when the “Apply Scale” toggle is ON. Otherwise a value of “1.00” will be 
implied.  
 
 
The drawing scale can be automatically set for each design file by one of the 
following two methods: 
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1 - Reading the Drawing Scale last saved to the Design File by CADconform.  
This element contains the drawing scale last saved, and is read whenever a new 
drawing is opened or CADconform is activated. 
2 - Reading the reference attachment scale from a standard border sheet.   
This is achieved by CADconform comparing all current reference files to a 
predefined list of standard border sheets. If a match is found, then the reference 
attachment scale for this model is read and the Drawing Scale is set to this value.  
If both 1 and 2 are set, then 1 will take precedent, which allows the user to 
override the interpreted Drawing Scale for particular drawings where the scale 
needs to be overridden. If neither method 1 or 2 are set, then the drawing scale 
dialog box will automatically open to allow the user to specify the drawing scale. 
The radio buttons below the scale options will show which method was used to 
read the active scale.  
The Save and Delete buttons will only be enabled if the scale method is set to 
“User Defined”. If a saved scale already exists for the active design / model, then 
the Save button will be disabled and the Delete button will be enabled. Similarly, 
the Delete button will be disabled and the Save button enabled if no scale is 
currently saved. If there are no standard borders defined or attached to the 
current design file / model, then the “From Border Ref” radio-button will be 
disabled.  
Multiple Scales  
If more than one scale is defined in one design file or model, then each scale can 
be defined in the “Multiple Scales” definition of the Drawing Scale dialog box, 
separated by commas. If this option is not visible, then press the down arrow icon 
on the bottom right of the dialog box to expand the window. The multiple scales 
can also be saved to the design file, or read from standard border sheets.  
Defining multiple scales effectively means all features in the design file can be 
interpreted at any of the multiple scales defined. This can create ambiguity if only 
specific areas of the drawing are at different scales. If this is the case, then it is 
better to disable multiple scales, restrict Conform or the Report Generator to 
those areas individually using a fence, and run the tool at the one specific scale 
for that area.  
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Step 5.  Using CADconform Drafting Menu  

• Selecting the model type provides a pull down of five selections 
 



Appendix A-5 
Plans Preparation Manual 

CadConform Drafting 
                   

USACE 
Page 7 of 8 

 
o From the Drafting category group menu, select the menu group and 

the item you wish to select for you drafting task.  For example, 
General Information opens a list of types of text and symbols. The 
selection calls a Microstation command to place every feature.  If 
you select General Notes for the menu shown above, a place text 
command will be started.    

 
o Cell or Symbols.  The lower portion of the drafting menu in the 

example shown above shows the Civil Symbols.  If this item is 
selected an  active cell library dialog.  The type of cell then needs to 
be attached through the Microstation place cells workflow. 

 
o Patterning/Hatching. Pulls up pattern/hatching to select for 

attachment to the model file. 
 

o Manuals. Link to the AEC CADD Standard 
 

o Tear Off.  The tear off command allows the drafting menu to tear off 
to show the model type drafting menu separately.  It displays four 
icons locate tools, turn off filter, set drawing scale, save, expand 
tool bar (show cell, show linear, show text, and show dimension, 
clear filter, and shrink tool bar) 

 



Appendix A-5 
Plans Preparation Manual 

CadConform Drafting 
                   

USACE 
Page 8 of 8 

 
 

• The selection of tools allows twelve tools to be accessible. 

 
 
 

o Change Feature tables.  This command allows the file to be 
branded to a different model feature.  

 
o View Feature Tables.  Views the feature table model branded to 

and the version of the feature. 
 

o Drawing Scale.  Drawing scale allows the user to reset the scale of 
the model file. 

 
o Save Settings.  Saves current setting of CadConform. 
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Step 1.  Select Feature Table.  Before a report can be generated, the Feature 
Table must be chosen. The chosen Feature Tables define which features are 
allowed for each design file in the report. Once the Feature Tables are chosen 
and imported using the Feature Table Manager, the Report Generator dialog box 
will open.  

Step 2.  Run the Conform tool. (Begin the standards checking process) 

Select the Checker Icon for the Conform tool bar. 

 

Step 3. Start the Conform Summary. 

• Select Start. CADconform begins 
scanning the design file.  The dialog will 
indicate the Feature Table to which the 
file is branded.  When Conform has 
finished scanning the current design 
file, a summary of the number of 
conformed features is displayed, as 
well as the number of features 
ignored or added 

• Finding Unmatched Elements.  The 
Conform dialog, after finding an 
unmatched element provides a 
suggested replacement. 

o The dialog will display the 
unmatched element at the top 
of the checker dialog.   

o The center section displays a 
votive list of possible 
symbology that may be 

correct. If one of the suggested items are chosen,  
o Note that the unmatched element is highlighted in the design file. 

The element will, by default, blink to indicate the error. 
o The lower section of the dialog indicated the difference in the 

unmatched element and the selected element. 
o Select Change or Change All to conform the selected element. 
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• Next:  Next finds the next invalid element once an element is corrected. 
• Ignore:  Ignores the current invalid element and continues scanning. 

 
• Ignore All: Ignores all instances of this unmatched feature until the end of the 

design file. 
 

• Change: Changes the symbology of the unmatched feature to match the 
symbology of the selected feature in the Feature Table. 

 
• Change All  Changes all features in the design file that match the current 

unknown feature, to match the symbology of the selected feature in the 
feature table. Conform will then report how many changes were made to 
the design file, and then allow the scan to continue from where it left off.  

     Change All will change all elements that match the offending element an 
     only elements that match that element error. 

 
When all elements are changed to conform to standard symbology in the 
file, the dialog will show blank as before the checking process started. 
When Start is selected again, any unmatched elements will again be 
shown.  If some unmatched elements remain for reasons specific to project 
demands, such as, presentation quality demands, or no element was 
available for the design need, or some other approved reason. It is 
required to provide a notation made to supplement the Quality report 
submitted at Project Quality Review time. 
 
Step 4.  Run the Report Generator .  The Report Generator is used to create 
reports on a list of design files that do or do not match any of the features in the 
chosen Feature Tables.  
The Feature Tables must be chosen before a report can be generated. The 
chosen Feature Tables define which features are allowed for each design file in 
the report. Once the Feature Tables are chosen and imported using the Feature 
Table Manager, the Report Generator dialog box will open. 
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• Select Report.  The report then processes the file and provides 
information as to the number of elements checked, number of errors, 
number of files conformed. 

• Select Ok. 
 
 
 
An information block is shown 
as indicated above and 
provides the number of 
elements checked, errors and 
files conformed  
 
 
 
 
 
Design Files List Box Displays 
the chosen design files to 
generate the report on. This list 
can be edited by clicking the 
“Add / Remove” button. Master 
design files are displayed in 
black text; referenced design 
files are displayed in blue, and 
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missing reference files are displayed in red. Reference files are indented once for 
each level of nesting. 
 

 
 
A Design File Summary Table 

 
 

The Design File Summary table below shows the symbology, coordinates and file 
position of every element that did not match any features in the Feature Tables.  
Note that this report can be very time consuming to produce in files with many 
errors.  
 

 
 

 
Error Summary.  Produces a summary of each error in the design file and how 
many times it occurred. This optional report contains one row for every error in a 
design file. The same error may appear multiple times. 
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• Feature Summary Error Report 

Is an optional report that contains one row for each unique feature in a design 
file. The report lists each unique feature and how many instances of each were 
found in every design file.   
 

o Column Name Description 
o Design_File The design file in which an error was found 
o Feature The full name and parent groups of the feature 
o Symbology The symbology of this feature 
o Num_Features The number of instances of feature errors in the named file 

 CadConform  
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Icons 
The Report Generator dialog box 
provides shortcuts for the menu 
commands. The icons are 
described below: 
 
Open Job 
Opens a pre-defined Report Job 
file. See the “File > Open Job…” 
menu command. 
 
Save Job 
Saves the current Report Job file. 
See the “File > Save Job…” menu 
command. 
 
Add Design Files 

Opens the File Selector to add and remove design files to or from the report 
dialog. See the “File> Select CADs…” menu command. 
 
Remove Design Files 
Removes the selected design files from the list. See the “Edit > Remove” menu 
command. 
 
Find Reference Files 
Finds the reference files of the selected design files. See the “File > Find DGN 
Refs” menu command. 
 
Set Levels 
Sets the reported levels of the selected design files. See the “Edit > Set Levels” 
menu command. 
 
Drawing Scale 
Opens the Drawing Scale dialog box. 
 
Advanced Options 

Opens the “Advanced Options” dialog box that provides the options: 
 

• View Report.   
• Report Type 



Appendix A-6 
Plans Preparation Manual 

CADConform File Checking 

USACE 
Page 7 of 8 

• Info 
• Design Files 
• Error List 
• Error Summary 
• Feature Summary 

 
 
 

• Feature Summary 
• Error Summary 
• Error List 

Several different report types can 
be generated for the chosen 
design files. They include:  

• A Feature Summary  
• An Error Summary  
• A Detailed Report of Each 

Error A  

Additionally, two compulsory 
reports are generated every time 
a report is produced: 

• A Report Information Table  
• A Design File Summary Table  

Report Generator 
The report generation process involves the creation of various report tables in the 
database. Reports can be manually or automatically exported to text or comma 
separated (CSV) files. 
 
 
Conform 
Conform is the tool that changes the symbology of design file elements to match 
a feature in the Feature Table. It operates similar to a word processor, allowing 
each error to be viewed, corrected or added to the feature table individually. 
 
Scan Options 
Scan Options define user options specific to an individual run of Conform. This 
tab page has the following dialog items: 
Scan Levels 
Drawing Scale 
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CadConform for Microstation User Manual 
The Scan Options tab page of the Scan Criteria Dialog Box 
 
Generating Reports 
The Report Generator is used to create reports on a list of design files that do or 
do not match any of the features in the chosen Feature Tables. The Report is 
generated as a database table, either in the CadConform database, or in a 
separately chosen ODBC data source (as defined by the user). This database 
table can then be printed out, converted to a text file or other file format, or used 
to generate a customized report, by using a database application such as 
Microsoft Access.  Several different report types can be generated for the chosen 
design files. They include: 
A Feature Summary 
An Error Summary 
A Detailed Report of Each Error 
A Watermark Report 
 
Additionally, two compulsory reports are generated every time a report is 
produced: 
A Report Information Table 
A Design File Summary Table 
 
Note that to overwrite an existing report, the user must be either: 
An administrator, or the creator of the report. 
 
As with Conform (checker), the Feature Tables must be chosen before a report 
can be generated. The chosen Feature Tables define which features are allowed 
for each design file in the report. Once the Feature Tables are chosen and 
imported using the Feature Table Manager, the Report Generator dialog box will 
open. 
The Report Generator allows the user to process one or more design files for 
each report. Reference files for each design file can also be reported on by using 
the “Find References” tool.  
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Project Wise Scan Reference tool scans various folders and files to find 
reference files that have been attached to project sheet files.  The Scan 
Reference tool as shown and described below gives the user the ability to 
redefine the connection to reference design files that were attached outside of 
the Project Wise environment. For example, AE design file submittals that have 
been imported into project wise would not recognize the previous reference 
attachment paths. Therefore new definitions must be defined. The Scan 
Reference tool does that task for the users. 
 
The descriptions below will lead you through the scan reference process. 
 
Step 1 Import Files  

• Open the folder or source containing the files you wish to import into 
Project Wise  

 
• Open the Project Wise XM Explorer application and browse to and 

open the folder where the files are to be placed.  
**  Be sure to place sheet files and model files in the appropriate 
folders.  These file should always be segregated so don’t place 
sheet and model file in the same folder during the import routine. 
 

• Select the files in the source you wish to import.  

 
 
Once the files are imported into the Project Wise Explorer project folder 
the Select a Wizard dialog will appear as seen above. 
Select ‘No Wizard’ icon and select OK.  The file(s) is immediately added to 
the Project Wise folder.  Repeat the same process, for Model file importing 
them into the appropriate folders.  
 

 
 
 
 



Appendix A-7 
Plan Preparation Manual 

Project Wise Scan Reference Workflow 

USACE 
Page 2 of 6 

Step 2 Scan References 
From the Project Wise dialog main menu, select Tools, and then Scan Reference 
and Link Sets as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This dialog is only an introductory 
dialog.  Press Next. 
 
 
 
 
 
 
 
 
 
 
 

 
Select Next in the Scan Reference Files and Link Sets dialog.  The Link Sets 
option box is not a setting that affects our type of design file workflows but having  
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the dialog box checked will not hinder the workflow we are performing so you can 
leave it checked if you wish. 
 
 
In the dialogs in below are shown the selection of the folders that contain the 
master files. Master files are those folders that contain the sheet files or those 
files that have references attached to them. Notice the Select Folder that will 

appear once you select the folder icon  
 
from the main dialog.  Be sure you are selecting all folders that contain the 
master files for whose reference you wish to search. 
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Once the folders 
containing Master files 
have been selected 
Choose the Application 
type for which you wish 
search. It is suggested to 
select Microstation, 
Microstation V7 and 
Microstaion V8. This will 
insure that the files are 
found no matter which 
application has been 
assigned to the files 
during import. 
 
Now that the files and 
folders containing 
reference attachments 
have been identified,  

Select Next to identify the folders to  
search for reference file attachments as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Enable Priority Search — If checked, you can select the folders that are to be 
scanned for the presence of references documents, and also the order in which 
the selected folders are searched. This is different than the previous two pages 
you encountered, which dealt with scanning for the presence of master 
documents.  
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If this option is off, you cannot select any other items on this page, and you must 
instead enable a proximity search on the next page of the wizard. 

 

If no priority search is conducted, Figure 8 provides the settings for a proximity 
search.  Select the appropriate selections from the Proximity Search Settings box 
and select Next> 

The Reference File search 
Options Continued in  the dialog 
to on the left provides for the 
identification of a location for 
the search log file. Select the 
Browse button and identify a 
location and create a name for 
the file if desired. 
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The wizard dialog above shows the last scan references wizard setup dialog. 
Once finish is selected, the scan will begin.  The dialog will update the user as to 
the progress of the search and when complete will display a Scan Summary as 
seen  above.  The examples above was no using an actual project so the results 
are not satisfactory. The process is the same however and the success of the 
scan will depend on the user identifying the appropriate files and folders to scan.  
Knowing which files and folder contain the reference files is important to a 
successful scan. 
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IPLOT BATCH PLOTTING 

 
WORKFLOW: 
Step 1.  Project Design file preparation. 

• Insure that the DGN files are formatted correctly and standard compliant.  
• Open the Project Wise IPLOT Organizer application by selecting the 

IPLOT Organizer Icon on your desktop or from the Program list. The 
Organizer should open as an empty dialog on you screen as shown 
below. 

 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
   

• From the IPLOT Dialog main menu, select File> Project Wise Login. 
o You should see the Login Dialog similar to the one you see below. 

 
 
 
 
 
 
 
  
  
 

Step 2 Setup Plot Properties 
• The Setup Properties have been provided with some standard configuration 

that may be helpful.. 
Figure 6 
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o First, Load the ‘Create Plots’ Dialog by selecting from the IPLOT File 
Menu item the Create Plots item.  You will see the Dialog below 

  

 

 Select the Browse Button to get 
the Set file. 

 

 

 

 

 

 

 

o Selecting the Browse button will display the Project wise Select Settings 
File dialog. Browse to the SAJ_EN_Workspace\Resources directory to 
select the settings file. As shown in the dialog below. 

 

 



Appendix A-8 
Plans Preparation Manual 

Plotting Using Bentley IPLOT 
 

USACE 
 

Page - 3 - of 16 
 

 
 
 
 
 

o Notice that these Pre-set or SET files are named for the actual sheet 
size 

 
 
 
 
 
 
 
 
File Added from 
Project Folder 
 
Set File loaded from 
the PW resources 
folder and is then 
copied to the Local 
PW folder as seen 
here. 
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o Some are set to produce half-sized plots sets, some metric, etc. 
o The Presets have been prepared and stored in Project wise in the 

SAJ_EN _Workspace\Resources\IPLOT directory for you benefit. 
The  
user can choose to create the plotting properties from scratch as 
project requirements dictate. This guide shows various examples of 
the presets for demonstration purposes only. 

• Once the Plot settings file is loaded the files to be plotted should be 
loaded. The dialog below shows the files already loaded in the add file 
dialog.  If the user is creating the plot configuration ‘from scratch’ the files 
to plot must be loaded before the plot properties can be defined.   

• Once a settings file is loaded and the files to be plotted are also loaded 
select the OK button to load the files in the IPLOT Main Dialog as shown 
below. 

• Next the Main IPLOT dialog will appear showing the file to be plotted 
loaded in the dialog. 

 
 
 
 

o As each file loads the window at the bottom of the IPLOT main 
dialog, the widow lists each file as it is copied out. It tests the file 
with the attributes which the SET file is assigning to it.  If there are 
errors they will be listed beneath each file listed. If no errors exist 
the lower window will just list the files as the property attributes are 
assigned. 

 
 

o Once a Batch plot has successfully been made a batch ‘plotset file’ 
can be saved, containing all the configurations and files, this file 
has the IPS extension on the file name.   
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o Later the file can be opened and re-plotted as needed by opening 

the previously created IPS File to the IPLOT Dialog and plotting. 
 
• The following examples show various IPLOT properties dialogs that are 

used in setting up a plot set to be saved as an IPS file similar to the one 
shown above. 
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Notice below that there is a field to  
add either a Design Script or a Microstation Pen Table.  It is recommended that 
you use Design Scripts that have been created and provides the best results in 
most cases. 
Design Scripts are IPLOT pen tables and are created using basic language code 
syntax. For special circumstances, special Design Scripts can be produced in a 
few minutes.  It is very important that you provide a consistent Logical Name in 
the Reference file dialog. If you have the same file referenced numerous time in 
a project each logical name must be the same.  i.e., a reference file showing 
property/lot lines may have a logical name of ‘Prop’.   
 
The General tab above in the IPLOT Properties dialog.  The majority of the fields 
in this tab are not used for most applications. Sections of greatest importance is 
the Resymbolization section and the Microstation Pent Table section.  The user 
can use either method to assign graphic symbolization to the plot files as 
needed.  The Admin team has created some design scripts or IPLOT pen tables 
for special purposes.  These are more difficult to generate due to the strict basic 
programming language that must be used with very specific syntax formatting.  
The user may instead choose to use the Microstation pen tables to symbolize 
their plot files. The only caveat is that the user will find creating the pen tables 
easier while in Microstation Plotting dialog.  
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This dialog shows the properties of the Area tab.  The most valuable part of this 
dialog is the choice to select the sheet file as the definition of the plotted page. In 
this way the plot scale is set based on the page size.  The Sheet model set up 
while in the design file has determined the scale of the plot and the page size.  
The second choice is selecting the plotting shape and scale base on the size of a 
fence.  The button titled Describe Plot Shape allows the user to define a shape 
by level name, color, line style, and/or weight.  If the border is a cell, the Describe 
Fit Elements button can be selected and the cell or element properties described 
in the fields provided. 
 
Describe plot shape provides fields to enter the definitions of element attributes 
of a shape. For example, the selection might be the shape at the trim line around 
the border/title block. This trim line shape is consistent in each file since the 
same border is referenced to each sheet file to be plotted.   
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Below is the Describe Fit Elements Dialog.  This is most useful for a border that 
is a cell. The Element type can be defined as a Cell and the Cell name field can 
be defined with its name. 
 

 
 
 
 
 
It is recommended that in all cases possible that the user creates Sheet Models 
when creating the sheet files so that the plot definitions is defined simply as 
Sheet. Then the plot scale is already defined by a sheet size. 
 
The Layout Tab is the last area of focus for general plotting needs.  This dialog 
as shown below, provide the user the opportunity to define the paper size, the 
units (inches is used for all of our non-metric projects), Rotation should always 
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defined as Align with X axis for all landscape plots. If the Size and scale is 
defined as the paper size X an Y dimensions, then the scale need not be defined.  
 
 

 
 
 
Once these items are set, select the OK button and these settings should be 
applied to each of the files in the plot set.   
 
Step 3  Plot the Drawings 
Selecting the print icon from the IPLOT main dialog will send the selected plots to 
the printer selected. 
 
Step 4.  Archive successful plot solution 
Once a satisfactory plot quality is achieved, save the IPS file containing the plot 
files.  IPLOT creates two files once a plot set is created. One has an (.i) file 
extension and the other an (.m) file extension.  These files are saved in the 
Project Wise local Folder ID where the IPS file is generated.  These files can be 
used to send the plot files to the plotter later. These files are more secure than 
the IPS file that can be easily changed, files deleted, or reordered. Call the 
CADD Coordinator for more information. 
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IPLOT FOR SINGLE PLOTS 
 

Single plots using IPLOT from Microstation can be achieved without using the 
IPLOT Organizer used to create batch plots.  To start the IPLOT application, start 
Microstation open the file you wish to plot and follow the steps described below. 
 
Step 1. Start IPLOT 

• From the Microstation File menu, select IPLOT… see the dialog below. 

 
 

• This will open the IPLOT plotting dialog… see the dialog below 
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• In this view of the IPLOT dialog, you can see the various options and 
menus. 

o Look at the left side of the dialog the job name is listed (this is the 
file name by default). 

o The Printer field list the printer selected.   
 Printers are configured for use with IPLOT.  Only a select 

few printers are configured for IPLOT. Contact the CAD 
Manager for a complete list of which printers are configured. 

o Paper Size is a critical field. We use only two sheet sizes or paper 
sizes, ANSI D and ANSI E for full size plots.  If half-size plots are 



Appendix A-8 
Plans Preparation Manual 

Plotting Using Bentley IPLOT 
 

USACE 
 

Page - 12 - of 16 
 

planned, select a size that has the same aspect ratio. For example 
if the sheet to be plotted is an ANSI E full size and a half-size is 
desired for the plot, then you should select the ANSI C paper size. 
Likewise choose an ANSI B for a half-size of the ANSI-D. 

o Placing a check mark in the “Use full paper size” will expand the 
virtual plot size to the margins of the paper size chosen if the 
aspect ratio is compatible and a fence is placed at the boundary of 
the file. 

o The view below shows the dialog with the printer, paper size, fence 
placed, and use full paper size selected  

 
 
 
 
 

 
• Next, in the IPLOT dialog, choose the File menu item and then choose 

one of the items explained below. 
o The Select plotting files opens a small dialog of the same name. 

This dialog will be used by out organization to select the Design 
Script or IPLOT Pen Table. The Browse button at the right of the 
Design Script field will start the Project Wise  browse window to find 
and select the desired pen table. 
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 See the Project Wise browse window shown below. In this 
case the E-size-black pen table has been chosen.  This file will 
operate within the plot file to cause all lines and text to be 
plotted black as well as defining line and text weights.  Other 
pen tables provide different plot file modifications such as 
plotting contours in a gray scale and reducing the priority of 
those elements so that other feature element can be  
displayed on top of any contour elements to avoid hidden 
feature line in the final plot. 

 

 
 

o The Select Settings  option. (It is assumed that you are logged in to 
Project Wise.)  
 This item will open the Choose Settings File browse window 

from Project Wise. Each of the Settings files or .SET files are 
previously set up containing all of the appropriate settings 
including the attributes of the border shape on to which a 
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fence will be placed, the pen table to be use, the sheet size 
and all other settings that would normally be set manually. 

 
 

 In the example above the ANSI-E set file Provide all needed plot 
properties. See the example below to see the automatic setting that 
will be applied to either in this example of a single plot or in the 
IPLOT Organizer. 

 Shown here is the General tab of the Setting File. Note that the 
Design Script or Pen Table is selected as well as Update from the 
Design File. 
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 Shown here is the Area tab with the Describe Plot Shape 
selected. Note that these settings define how  and where the 
fence will be placed.  These setting can be described as  

 
a level name or by color, weight and style of the shape to be used. 

 
 Shown here is the Layout tab. Although this tab is the first to 

be displayed when the plot file settings opens, they have 
been show in order from left to right for the purpose of this 
workflow.  Paper size, plot units, plot size and scale, rotation, 
and plot placement origin on the plotted paper is shown.  
Mirror is not used in our general workflows. 
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The additional tabs are not generally used in the plot setups in our 
workflows. 

o The dialog shown below has been completed and is ready to preview or to 
plot.  Plotting can be accomplished by sending to a configured printer or 
plotter or exporting to a PDF file. 

                                                                                             
Either of these three 
option should result in 
the same quality result. 
 
For assistance contact 
the Design Branch 
CADD Coordinator . 
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To obtain legacy drawings or archived images, for example, files that were stored on 
the old Falcon system, you must do the following steps: 
 
Step 1 Visit the web address http://saj-ap11ncc/client/dip/. 

 

 

http://saj-ap11ncc/client/dip/�
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Step 2 Select a specific area in which the legacy file may be stored.  For example, 
click the link for either Falcon Area 1 or Falcon Area 2.   
 

 

I r.:. Dueclory V,ewer Wlndov;. Inlernel EKplorer ~~~ 

il My Po-to! Q R~ ,(om (CcrrWlg Scan) Q R~ ,:om (New ReIe""", ) if] V. tDO' Spo-t, 

Fil . N~ ,"" Author Comm~ nts Fil ~ Siz ~ 

el 3320 

eJ 8-S,m. 

eI •••• 
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eI bigb<r.d 
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O elL 
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Step 3  Once you navigate through the folders you will reach the file list.  Click the 
link on the file.  The system will process the file and generate an image file to be 
displayed.  
 

 
 
Below are detailed the follow-up process steps. 
 
1) If the displayed file shows the correct drawing, contact CADD Manager and 

provide him with the directory path and file name being requested. 
 
2) Before the file can be sent to the users, The Administrator must execute a 

program that will convert the legacy file to the current version of Microstation.  If 
this is not done, a majority of the drawing objects may be lost and the file will be 
missing many elements. 

 
3) Once the file(s) is processed, the file location/path will be forwarded to the 

requesting user via email indicating the Project Wise file(s) new location or 
placed on a CD or DVD if needed. 
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Item 1. Determine Design Plotting Scales and associated graphic entities. 
Plotting scale is critical in order to determine text heights to be used in the design 
file. Design work prepared  in design model files as apposed to sheet files is 
especially critical to be cognizant of the resulting plotted scale if or when text is 
used in a model file. 
Consider the checklist items below when preparing model and sheet files: 
 
Checklist for Text associated Scale(s) 

• What will be the plot scale? 
•  
• Set text heights as appropriate for plot scale. (Use Text Styles from 

Standard DGNLIB.  File name: USACE-Dim-TextstylesTT.dgnlib  
• Set the appropriate line type scales. 
• Plan features. (Place on sheet file, proportion/scale, etc. 
• Symbols (weights, size, text legibility). 
• Detail/Section Scale (size on sheet), special treatments of section cut lines 

using enhanced weights and line styles. 
• Feature titles, subtitles, north arrow, graphic scale(s). 
• Consider scale for section and details presentation requirements for: 
• Text fonts and sizes 

o The text definitions below are defined by using a plot scale 
multiplying a text height sized at a scale of 1”=1’ and are based on 
finished text sizes at plot time.  The use of text styles for 
placement is the required method of text placement. The 
Drawing Scale tool and scale factors used in sizing text is 
described in the General Appendix workflow entitled ‘Using 
Text Styles and Drawing Scales’.  

• Main subject titles should be shown at .200 x scale 
factor.  Font: Arial Black. 

• Sub titles should be shown at 0.175 x plot scale and 
Arial Black Font. 

• Headings should be shown at 0.140 x plot scale.  
Font: 3 (Engineering). 

• Annotation w/ leaders at 0.120 x plot scale. Font: 
Arial. 

• General Notes at 0.120 x plot scale. Font: Arial. 
• Graphic Scales should be consistent in type and 

format throughout the project drawing set. Coordinate 
with the project lead technician. 

• Hydrographic Text including (water body labels such 
as creek, river, basin, lake, and ocean titles), flow 
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direction labels, channel range text, etc. Create at a 
22 degree slant. 

 
 
Item 2. Sheet file/Drawing Layout Presentation 

• Plotted drawing layout must be clear in its presentation; drawings must 
clearly communicate design purpose and concepts.  In order to meet this 
goal, you must be particularly attentive to display presentation purpose 
and focus. For example, if you are showing features to be constructed as 
well as existing features, the best way to accomplish this is the use of line 
styles and weights.  When level symbologies do not provide such 
segregation, level overrides coupled with the discrete use of reference 
files is the proper methodology. Your senior technician or CADD Manager 
can help with such workflows. 

• An alternative method is to use pen tables to achieve graphical 
discrimination in dgn file plots. Usually a simple pen table can be prepared 
to achieve the desired outcome. It must be noted however that the use of 
pen tables, while achieving the desired result in a plot does not solve the 
issue when looking at a dgn file in Microstation or when exporting the dgn 
file to other users outside of your workspace environment.  

• Use the categories below to help in focusing the drawing preparation on 
improving presentation quality. 

• Line weights and line styles: Line weights contrast drawing features and 
focus the viewer’s eye to the focus of the displayed feature. Line styles 
help to show differences in the features’ status such as existing or 
proposed features, hidden feature lines, items to be demolished, etc. 

• Feature Position: How the features are positioned in the sheet can make 
the difference between an unorganized sheet and a clear and quality 
presentation.   

o Care shall be taken in balancing ‘used’ versus ‘white space’ in a 
sheet. Items should be placed so that each sheet is neat and 
avoids the appearance of wasted space or cluttered sheets.  If 
needed a new sheet should be created to avoid such crowding. 

o Each sheet shall follow rules of drafting etiquette. Major focus 
features shall when ever possible be oriented on a sheet to give 
order to the information on each sheet. 
 Sheets flow from left to right and top to bottom. In other 

words main features should be ordered and placed from top 
left to the right and down. If you have a plan (main feature), 
Detail, and a section, then the proper order is to place the 
plan in the upper left portion of the sheet (left to right), the 
Detail below on the left and the section below to the right of 
the detail.   
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• Graphic scales and north arrows shall be placed in the lower right of the 
plan or sheet.  When not possible, place the north arrow as close to the 
lower left of the plan feature as possible.  
 

• Text Fonts, Sizes and Weights: Historically Corps design text usage has 
its roots in the Leroy system.  CADD text fonts in the Corps emulated 
those font styles.  Many Corps customers use AutoCAD design based 
software with fonts unrelated to our Leroy-based standard texts and this 
difference has always caused translation problems.  Substitution of these 
fonts when translating form on format to the other has always caused 
major presentation quality problems. It was determined that a common 
font style was needed in order to avoid such problems forcing 
unnecessary editing problems.  The common text between both platforms 
is True Type fonts.  Among these fonts, Arial is the cleanest and most 
readable.  A-E design firms and Corps personnel preparing project 
designs shall use the True Type Arial and Arial Black fonts in all 
sheet files, model files, index sheets, borders, and cover sheets for 
all design work. See the General Appendix workflows entitled ‘Using 
Text Styles and Drawing Scales’ and ‘True Type Text User Guide’ 
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Scale Factors: Discussion 
A procedural change is in effect for Design Branch’s project design workflows.  We will 
begin using design file borders (title blocks) that have been created at actual sheet sizes, 
i.e., ANSI D or ANSI E (34”w X  22”h and 44”w X 34”h respectively). A different scale 
factor must be applied to the ANSI sized borders when referencing to sheet files.  
 
Scales & Scale Factors 
Sheet Models and Borders in SAJ Workspace are configured using an absolute 
scale factor. The Use of this scaling method is important to the sheet model 
layout methodology. 
 
Expressed Scale          Scale Factor Definition 
1” = 1”     1    1 inch to an inch 
1/2” = 1’   24  24 halves to a foot 
1/4”=1’   48  48 quarters in a foot 
1/8”=1’   96  96 eighths in a foot 
1/16”=1’   192  192 16ths in a foot 
 
1”=10’    120  120 inches in a foot 
1”=100’   1200  1200 inches in a foot 
 
This method then uses the scale Factor to multiply sheet size or border size to 
achieve a real-world sheet size that will expand to encompass the design feature 
area.  For example, a civil scale of 1”=100’ will use a scale factor of 1200 to 
multiply a 34”X22”  (D) border size to achieve a real-world border of 3400’X 
2200’.  (34” X 1200=40,800” / 12”= 3400’) (44” X 1200=52,800” / 12=4400’) 
 
When we reference a border file for an ANSI E sheet size that has been set up at 
the actual sheet size of 44”X 34” a scale factor like that shown above will have to 
be used in order to enlarge the paper sized sheet model or border to a real-world 
size such as described in the paragraph above. 
 
 
This new procedure will be used for all new projects started.  In addition any 
project that is currently in the design phase but in which no border has been 
incorporated will be required to use the new borders.  The new borders can be found 
in Project Wise at SAJ_EN Workspace\Borders\*.*. 
 
This changes how we define and use scale factors for referencing borders and index 
sheets. The legacy borders use until now were 12 times their actual  size.  New borders 
have been created at actual paper sizes, i.e., ANSI D, ANSI E, etc.  Also included in the 
new files that are changing sizes are Index sheet templates, and Cover sheets.  This 
change is necessary in order take advantage and use the use of Sheet Models in our 
project design documents.  
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Using Sheet Models 
The new paper sheet sizes for the borders, cover sheets, index sheets in our projects will 
use a sheet model workflow.  The explanation and workflow is explained below. 
 
Sheet models are created by redefining the properties of a Project Sheet File (The 
defining of an actual scaled virtual paper sheet). The following steps will explain the 
settings and steps involved in setting-up and using sheet models. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Above, you can see that the file shows the sheet (ANSI E in this case), and is indicated as 
a shadow box floating above the screen surface.  
 
Step 1.  Open the Models Dialog  
To access this dialog, select the Models icon from the Primary Tool palette.   

Figure 1 
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Figure 2 
 

Figure 3 

  
 
 
 

 
 

Step 2.  Create New Model and Define 
Properties  
(see Figure 2)  Select the first Icon 
(Create a New Model) You will initially 
see the Properties dialog. Set the model 
parameters. In this case in Figure 3 the 
Type is set to Design which is the Default 
model that the user normally sees when 
viewing a design file.  
 
 
 
 

 
 
 
 

 
 
 
 

 
 
 
 

 
 
 
 
 
 
 

 

Create New Model 

Sheet Size 
Pull-Down 

Scale Factor 

Scale Pull-down 

Figure 4 



Appendix B-2 
Plans Preparation Manual 
Scales and Sheet Models 

USACE 
Page - 4 - of 9 

 
Step 3 Select the Sheet option from the Type pull-down field in the Model Properties 
dialog.  This will cause the dialog to expand and more options become available.  The 
initial properties will look like the dialog above. In order to set up the sheet model select 
Sheet in the Type field pull down box. See Figure 4.  
 
 
Step 5. Begin to define the sheet model.   
Following the visual example in Figure 4. Set the Scale by selecting desired scale from 
the Scale pull down. Note that the scale factor to the left of the ¼”=1’-0” example has a 
scale factor of 48.000. Refer to the discussion at the beginning of this document. 
Increasing the scale enlarges the sheet by the scale factor multiplier. For example a 44” 
wide sheet would become 2,112” or 176’ wide after the scale factor is applied. 
 
 

 
 
 
 
 
Step 6.  (Non-Civil 
Projects) Create a 
new sheet model 
Reference the 
Border file to the 
sheet model  
The sheet model 
and new borders all 
share the same 
lower left corner 
coincident origin 
point or X=0, Y=0. 
Therefore when the 
border is 
referenced to the 

sheet model, there are the same size and the same origin. See  
the sheet model view in Figure 6. 
 
 
 
 
 
 
 
 

Figure 5 
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For next step for non-Civil project skip to Step 9. 
 
 
Step 7. (Civil Projects) Create new Sheet Model 
 
This step assumes that a new sheet file has been created using the standard procedures 
explained in the Workspace Information Document and the Project Execution Guide  

Common 
Origin 0,0 

E Sized border 
Referenced to an 
E sized model sheet 
using coincident 
method 

Figure 6 

Figure 7 
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Once the new DGN sheet file is created and opened, select the Models Icon from the 
Primary Tools Palette. This will show the Models dialog shown in Figure 6. 
From this dialog select Create a New Model as shown. A new model Properties dialog 
will appear as shown in Figure 3. Change the Type field from Design to Sheet, then select 
the ANSI sheet size to be used (ANSI D or ANSI E). Note that the model dialog now 
shows a new model. In this example the model has been name and a description given. 
This is a good practice in order to keep track of the models created. Once the model is 
created and the dialog dismissed, the Microstation view will show a white background 
with a default ANSI D sheet shown when you fit the view. 

Step 8 (Civil Projects) 
Reference the Civil 
Design Model file to the 
Sheet Model. 
 Reference the civil model 
file to the sheet model.  
The normal procedure in 
referencing is used 
placing the reference as 
Coincident World as the 
method of placement. 
Next reference the Border 
file as is normal at the 
appropriate scale 
sufficient to encompass 
the Design Model features 
as shown in Figure 7. 
Note the referenced 

design and border are not coincident with the Sheet Model.  In order to 
correct this issue record the lower left border trim line coordinates. In this example the 
coordinates are: X=78626.56 Y=440911.42. Next return to the Sheet Model properties 
and enter these coordinates as the sheet origin as shown in Figure 8.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7 

 
Figure 8 
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Figure  9 

 

Now that the coordinates 
are entered, select the OK button at the bottom of the Model Properties dialog and you 
will see that the sheet model now shows the sheet and the border are coincident with each 
other.  
The dialog shows the Type is Sheet, the Scale is set to 1”=100’, the sheet size is ANSI D, 
and the Origin is set to be coincident with the lower left origin of the referenced border 
file. See the result in Figure 9. 
The Title Block textual updates notwithstanding, this civil sheet model is now ready to 
plot.  
The user can find plotting procedures in  
detail in the Appendix A, Batch Plotting Workflow.  The routine below how ever is a 
short overview of the procedure 
 
 
Step 9 Plot the Sheet Model 
The drawing file containing the sheet model or the set of project drawings containing the 
created sheet models can easily be plotted without defining a shape or a fence for each  
drawing.  Simply select the Sheet as the plot method in the plot dialog as shown in 
Figures 10 and 11. 
 
Settings For Single Plots: 
Notice that in Figure 10 under general settings in the Plot dialog that the Area is set to 
Sheet. Under Printer and Paper Size, Paper is set to D.  Print Scale and Position sets the 
Scale to 100. 
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Settings For Microstation Batch Printing:  
Notice that in Figure 11, Batch Print Properties dialog, the Print Boundary Method is set 
to Sheet  rather than Shape, Fit Master, Fit All, or View.  This method eliminates the 
need for fencing or otherwise defining a plot area.   
 
 
Settings for IPLOT Batch Plotting from IPLOT Organizer 
Select the IPLOT Properties Dialog and then select the Area Tab. Under the Area Tab 
select t he Sheet option rather than Describe Plot Shape as usual. 
 
 
 
 

 
 

Figure 11 

Figure 10 

Figure 10 
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Final Note 
Contact the Design Branch CADD Coordinator with any questions about this or any other 
process concerning Branch Standard Procedures, methods or techniques.  
 

Figure 12 

Figure 12 
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Applying InRoads Design and Modeling To Projects 
Civil Designs prepared in Jacksonville District a predicated on design models 
developed using Bentley Systems InRoads Application.  This accounts 30% or more 
of the Districts Graphic design products.  Due to the ubiquitous nature of InRoads 
and the overarching requirement for compliance to Graphic Standards as defined in 
the A/E/C CADD Standards and the Local requirements for Project Design Product 
Standards, it seem fitting that a detailed step-by-step workflow be provided to help 
the Civil designer in the development of models.  The proper setup and assignment 
of model criteria will assure the compliance of graphic attributes to design files 
(DGN). 
 
How InRoads Preferences and Tools Relates to Standard Workflows 
InRoads is developed to operate using preset configuration (XIN) files, Template 
Libraries (ITL), Geometry Libraries (Alignments), Roadway Definitions (IRD) files, 
and the “out-of-the-box” InRoads installation provides each of these files, however 
they do not meet the corps standard.  The CADD Standard team has developed and 
provided standard compliant versions of these files for the users. This document 
provides a step-by-step procedure for setting up a project in the InRoads 
environment that will comply with the standards. 
 
For In-House Users, A-E Contractors and Partnering Corps Districts 
The Jacksonville District has provided a WEB page that contains a complete library 
of resources for use in preparing project design work for the District. The WEB 
address http://www.saj.usace.army.mil/Divisions/Engineering/CADD_MmgtSup.htm   
Among the information included on the web site are Standard DGNLIB files that 
provide Text Styles, Dimension Styles, Levels for discipline model files and discipline 
sheet files. You will find configuration files for Microstation design units. These non-
InRoads resources are mentioned because these files are needed in conjunction 
with InRoads in order for InRoads to interface properly with the design files it is using 
to develop its models.  InRoads resources are also found on the site for download 
including the InRoads standard compliant XIN file, standard template files. These 
two files contain all of the defined civil modeling features with assigned standard 
complaint graphic attributes.  It is strongly suggested that the users download these 
files and set them up in a central location such as the project area on a project 
server.  Jacksonville District users have the benefit of a workspace set up for each 
project in the Project Wise® (PW) Engineering Document Management System. See 
Unit 4 “Project Wise Workspace” for the explanation of the PW Workspace and how 
it works. See Unit 1 “Project Design Execution” for the description of the Project 
project workflow. 
 
The remainder of this document will refer to the various paths or functions of the 
design process as defined in the Jacksonville District Project Wise Workspace.  For 
information on how to set up projects in a non-PW workspace contact Pete Kendrick 
at Peter.d.kendrick@usace.army.mil  or 904-232-1912. 

http://www.saj.usace.army.mil/Divisions/Engineering/CADD_MmgtSup.htm�
mailto:Peter.d.kendrick@usace.army.mil�
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What follows is a Step-By-Step guide to start and develop a civil design in InRoads.  
There is not an attempt here to train the reader on the technical points of each 
InRoads tool but rather, a procedure to begin and apply the resources needed for 
the project design development processes.  For detailed InRoads training for specific 
tools and techniques see the Training Videos on the CADD Management web page. 
 
Step 1 Starting Microstation and InRoads in the PW Workspace  
 

• Open Microstation using an InRoads Icon. This will start Microstation and 
initiate the InRoads application.  If you are new to InRoads or if the program is 
newly install on your workstation. Follow these setup steps below. 

o Select the Tools menu item. 
 Select the Locks menu item. 
 Select the locks tool bar. This places the locks Icons at the top 

of the InRoads dialog. 
o Select the Tools and then the Application Add-ins menu Item. 

 Select the following add-ins. 
• Global Scale Factor 
• Horizontal and Vertical Element  
• Hydrology and Hydraulics  
• Quantity 
• Thin Random Points 

 These will load once you apply the add-in dialog. 
o Now the General environment is set up that will remain until it is 

changed by the user or a newer version of InRoads is loaded. 
o Make it a habit to select the Global Scale Factor from the bottom of the 

Tools menu each time you open InRoads.  The scale factor dialog will 
float on the screen and is relatively small so you can keep it on the 
screen and active to change scales as necessary. The scale factor will 
change text sizes when a new value is selected. 
 For example if the scale factor is set to 10 then the resulting 

feature annotation will be written at 1.25 ft high in the design file. 
Text heights are calculated from a base text height for 
annotation text of .125 ft in order to use the simple scale factor 
to calculate the final height (scale X .125).  

• InRoads operates in a Microstation design file environment. The Model you 
will create using InRoads only depends upon the DGN file when viewing 
graphics.  InRoads configurations assign graphic attributes using a “By-Level” 
definition from the design file in which the InRoads session is currently 
running.  So, if the current file does not contain the workspace’s by-level 
definitions, all graphics will be written to the default level without the 
appropriate color, line style, or weight. 
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• The Project Wise Workspace is dependant upon the dgn files residing in the 
appropriate PW project directory that has had a Workspace assignment made 
so that dgn files opened in that folder will have the settings and resources 
provided for the specific discipline folder. See Unit 3 “Project Wise 
Workspace” for workspace details. 

• When a design file residing in PW directory is opened the file is subject to the 
workspace resources, including the DGNLIB files that provide the discipline 
levels, text styles, and dimensions styles. 

 
 
Step 2 Create Project Defaults  

• From the InRoads File main menu, select the Project Defaults item. 
o This will open the Project Defaults Dialog that you see below. 

 
From the right side of the 
dialog, select the button 
labeled New and enter the 
new configuration name in 
the field provided. Once the 
new configuration is 
created, the remainder of 
the dialog can be 
completed.  Select the 
Preferences (*.xin) by 
placing you cursor in the 
field and then selecting the 
browse button. Then 
browse to the location of the 
Std_Civil.xin file.  For those 
using the PW workspace, 
the Civil\Inroads folder will 
contain this file.  Point to 
that file with the browse 
button. Next select the 
Project Default  
 
 
 
 

Figure 1 
Directory field and the browse button again. Browse to the PW project InRoads 
Directory and select the OK button.  Now highlight and Copy the path to the project 
InRoads directory and paste it to each field below stopping after pasting the 
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Roadway Design (*.ird) field.  Once complete, Select the Apply button and then the 
Close button.  
 
Step 3  Open the InRoads Survey Files  

• Select File > Open > Surfaces  
o Browse the PW file open dialog to the Survey Project, select the 

appropriate surface file or files and select open.  These will be read-only 
since they are in a survey directory. 

o Open the Survey Geometry Project file if present in the Survey location. 
(Some survey folder will not contain a Geometry Project depending on the 
survey contract type and scope.) 

Note: The Project Defaults will only allow one path for InRoads Surface, or ALG files 
so the survey resources will have to be opened without the benefit of saving the path 
to the Project Defaults set unless the user is setting these paths for Survey files only. 
 
Step 4  Apply the Project Default settings 
Once the settings are complete select the Apply button to set the defaults for your 
project.  After applying the settings select the Close button.   
 
Step 5 Open the project files 
The user will need to open the surfaces (DTM), geometry (ALG), templates (ITL),  
Roadway Designer (IRD) if these files exist for the project.  Open any Survey Files 
from the Project Wise Survey Data area as well.  If the project is new and models or 
alignments, templates and roadway designer files have not been created, then the 
user should rename the standard ITL file to reflect the project name.  The ALG and 
IRD files will also need to be created in none has been created and named for the 
project as well.   
 
Step 6 Create a InRoads Project File (RWK) 
The InRoads Project file or RWK file is a simple text file that InRoads uses to identify 
the path locations of the project model components such as surfaces, alignments, 
templates, roadway designer files. When the users creates this file and identifies the 
components the RWK file will automatically check out and open all of the 
components when the RWK file is opened from InRoads.  Select the Save As from 
the InRoads from the File menu option and the dialog shown in Figure 2 will appear. 

• Next select the Change button if the folder path shown is not the Project Wise 
path that point to your project area. If you have set the Project  Defaults 
dialog up correctly it should be correct. 

• Next enter the document name, file name and Description.  
 
 

Figure 1 
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Figure 2 

 
• During project development, you will have changed or added information 

to the project model components and you will need to pull up this dialog to 
modify the information.  If the Project file is not shown in the fields for 
name, file name and Description, choose the Select button and select the 
existing file to modify the information. 

 
Step 7 select the model components to Add and Update to the 
Project File. 

• Select the Options 
button 

• You will see the 
dialog in Figure 3. 
The Tabs contain 
the list of all the 
project file currently 
opened in the 
InRoads Session. 
The example shows 
the Surfaces tab 
open. 

 
 
 

Figure 3 
There is also a file name browse button at the bottom of the dialog. The user  
 
can browse to the Project Wise folder and add a file to  
the tab  to save to the Project Options tab. 
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• Select the add only box if the file to be opened is to be a read-only file 
such as a survey file.   

• Select the Update box if the file saved is to be a file that will be modified 
and saved such as the design model being developed.   

• Continue the same process for all of the tabs: Surfaces, Geometry, 
Template Library, Roadway Design, XIN Preferences, and Drainage.  

• Once all files are loaded and set for add or update press the OK button.  
o This will return the user to the Save Project File dialog.  

• Select the Save button to save the Project file settings. If the project 
already exists you will see the notification dialog shown in Figure 4. 

 
Figure 4 

 
• Select Yes if you desire to update the existing project file with the new 

information. 
• Be sure to save and check-in the project file to Project Wise when you are 

complete. 
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InRoads is the primary tool to prepare project sites civil design.  All earth work is 
prepared using the InRoads tools including but not limited to facility site design, 
canal or channel design, levee impoundment dikes, spoil disposal areas, 
dredging design and volume work. 
 
Basic elements for successful site development are geometry project files 
(alignments) (ALG)), existing digital terrain models (DTM), a template library File 
(ITL).  The Geometry file must be created or retrieved from other sources such 
as a project survey that defines site features such as a center line or a base line 
alignment. While not required, alignments make orientation to and within the site 
easier.  Templates can be used to define a levee or canal for example and can 
be placed at intervals along an alignment to produce a model in the form of a 
triangulated 3D mesh depicting the design shape of the proposed model.  The 
existing and modeled surfaces can be displayed in cross section to show 
graphically the modeled surface in comparison to the existing surface. 
 
The workflow described below describes the InRoads tools’ use in producing 
basic model and does not pretend to be a comprehensive description of how to 
model very complicated design work but should provide the reader with a usable 
workflow to follow in the design process. 
 
Step 1.  Open the Standard XIN file. 
The Std_Civil.xin file is found in Project Wise at: SAJ EN standards\InRoads 8.8 
and 8.9 standard\InRoads preferences v8.9\std_civil.xin.  This file is critical to 
producing design models that comply with the AEC Standard. You can also find 
the std_civil.xin file in your Project Wise project folder in the InRoads folder if you 
have had the workspace setup in your project area in the document management 
system. 
 
Step 2. Create a new or open an existing Alignment 
Normally there is an existing alignment for the project design model you will be 
developing. If not, project engineers will determine the alignment, location, points 
of intersection (PI), tangents, curve data, and elevations.  The InRoads designer 
can easily create the alignments based on the engineering data inputs. The 
Training videos on the Jacksonville District Web Site describes this process in 
more detail.  
https://intranet.saj.usace.army.mil/~rwp/cadd/InRoads%20training/InRoads%20tr
aining.html 
 
Step 3. Upload the Survey (existing surface) DTM for use in designing the 
proposed surface. 
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The user should investigate the existing surface for undesirable points such as 
spikes or false triangles.  The user should also determine the datum for both 
horizontal and vertical as well as the projection used in creation of the existing 
surface model.  This will be important in the design and construction process to 
come. From  the File option in the main InRoads Menu, select Open.  Normally 
the existing surface will be a survey dtm file found in Project Wise in the Survey 
Data project folder area.  These files are read-only files. Use caution in copying 
these survey files to your computer and be careful not to make changes to the 
files representing surveyed existing conditions.  

• View the triangles and rotate the file to check for inconsistencies or 
‘spikes’ in the surface. 

• You may want to view the contours to give a good feel for the topographic 
conditions of the site. 

• It may be a good idea to produce a set of cross sections along the 
alignment length to infom yourself of the surface conditions along the 
design corridor. This step and associated procedures is “just good 
engineering practice”.  Thoroughly investigating the existing data and 
informing yourself may save time later in the design process. 

 
Step 4a. Develop a model template 

• Develop a Design Template.  The InRoads template library contains any 
developed design templates. These templates define the model shape to 
be designed much the same as a typical section.  The widths and slopes 
are defined on either side of the center point of the template. Rules can be 
assigned as to how the template acts when modeling the feature.  A 
standard template library has been created for your use and is located in 
some common locations for you convenience. If you are designing a levee 
or waterway for instance, you may want to use one of the standard 
templates provided in the standard library.  You can modify the template 
points to redefine widths, slopes, end conditions and template behavior 
rules.  Each template point can be defined with symbology that complies 
with the AEC Standard format.  When the Model features are created and 
viewed graphically, they will display the standard compliant graphics and 
place the item on the correct level. 
See the Create Template dialog below.  Notice that all the tempate points 

are named these names will be used as digital terrain model feature names in 
the final model. 
 
Step 5 Create the Design Model using the Roadway Designer 
Once the template development is completed, you can use it in conjunction 
with the project feature alignment to model the design template relating it to 
the existing surface using the corridor modeling tools.   
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• Develop the Corridor model to define the modeling process. See the 

Corridor modeling tool below.  Notice that the alignment and template 
used and the distance in station limits are all items to choose when setting 

up the 
corridor 
model dialog. 

Once these items 
are selected and 
set, select the apply 
button. This will 
create a Roadway 
Designer Corridor 
definition to be used 
in the modeling 
process. When the 
Managage Corridor 
setup is done, close 
the dialog.  The 
Roadway designer 
will displaying the 
plan view of the 
alignment, a profile 
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of the alignment and the surface selected as well as a view window for 
displaying the active template to be applied.  The template will only be 
displayed after the template drops are defined. (see the Roadway Designer 
Dialog below). The second icon from the left will open the template drop 
dialog as seen in the Template Drops dialog shown. This dialog displays the 
Corridor name, station at which the template will be dropped, and a template 
library window from which you can choose a template to apply to the design 
model.  Once the design components are set, the Create Surface tool can be 
applied.  Find the Create Surface tool on the Roadway Designer icon button 
bar at the second from the right position. You will then see the dialog of the 

same title seen below. 
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1. The Create Surface dialog has a minimal number of items that should be 
applied. The name of the resulting model can be entered or select the 
New name for each corridor option and the corridor name will be used as 
the design model name. 

2. Empty design surface is prudent to have selected.  In cases where more 
than one attempt to run the model is made. This selection would eliminate 
redundant features in the design model. 

3. Add exterior boundary will restrict triangles from being created outside the 
design model parameter.  

4. Triangulate will initiate the triangulation process immediately following the 
successful model run. 

5. Create Surface(s) from allows you to select which corridors are processed                     
for surface creation. 

 
Model is Completed  
Site design is completed. This means that there is now a design model to 
compare against an existing DTM.  This can be done using the volume 
calculation techniques.  

• Triangulated volumes: this is the most accurate comparison between two 
dtm surfaces. It is calculated using a vertical difference. 

• Average End Area volumes: as this method states in its title the area of 
each cross section  indicating the area calculated between the two 
compared surfaces, adding the next cross section area and averaging the 
two areas, then multiplying the distance between them estimates the 
volume.  The accuracy of this method depends on a number of factors 
some of which are, distance between cross sections, variations of 
surfaces between cross sections, turns in the alignment along the corridor.     

 
See Unit 10 for creating InRoads Volumes. 
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Project design volume computations are produced in two fundamental ways, 
average end area and triangulated difference. 
 

• The average end area computation method depends upon reading the 
graphic area displayed in Microstation cross sections, calculating the area 
in the cross sections shown between two representative surfaces. This is 
done by averaging areas of two consecutive sections and multiplying by 
the distance between the two sections. This process is continued through 
the entire selected cross section set to achieve a total calculated volume 
of cut and fill displayed in cubic feet or cubic yards.  

 
• The triangulated volume method compares two surfaces over the entire 

area of the surfaces or to the extent of the smaller of the two surfaces and 
calculates the cubic volume between the surfaces compared.  This is the 
more accurate of the two methods and reports the exact volume difference 
between the surfaces. The accuracy and density of the data making up 
the two surfaces is key to the accuracy of the resulting computation.  Data 
density and accuracy is key to accurate volume computations for the 
average end area method as well.  But simply stated, triangulated method 
of computation is more accurate overall. 

 
Average End-Area Volumes Method 
 
Step 1.  Open and configure the Create Cross Section dialog set up and 
display cross sections. 
Two triangulated surfaces are required. From the InRoads main menu, select  
Evaluation then select Cross Sections and then Create Cross Sections.  This 
selection will display the Create Cross Section dialog see in Figure 1. 

 
Notice the various categories of 
settings in this dialog. Once the 
user sets up the desired format 
for the dialog the Preferences 
button at the bottom of the dialog 
can be used to save the settings 
to a custom name if desired. The 
two surfaces to be compared for 
volume calculation are listed in 
the dialog Surfaces window. The 
left side of the dialog lists in  
 
 

Figure 1 



Appendix B-5 
Plans Preparation Manual 

InRoads Volume Computations 
 

USACE 
Page 2 of 5 

tree and leaf format the items that can be customized to meet the project scale 
and graphic requirements.  
One of the more critical settings for the calculation procedure is the cross section 
interval defined.  Volume calculations can be adversely affected if the interval is 
too great because of variation in the alignment upon which the cross section set 
is cut.  Many curves or the degree of changes in alignment angles will produce 
skews in the comparative cross sections. Distances used in calculation of the 
average end area will be misrepresented between two skewed sections 
introducing errors into the resulting volume.  
 
Once the items are configured, select Apply at the bottom of the dialog. Once 
selected, the prompt will request that you identify a location to display the cross 
section set.  The point will identify the lower left corner of the cross sections. 
 
 
Step 2. Open End Area Volume dialog 
From the main menu select Evaluation > Volumes > End Area Volumes.  This will 
display the Dialog seen below in Figure 2. 
 

Figure 2 
 
Note that the Tree and leaf display on the left side of the end area volumes 
dialog. There are a few items in this list that need attention as a general rule 
when ever you choose this method of volume calculation. First from the general 
item be sure that the proper surfaces are selected to compare.  
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a. The Unsuitable Materials items define portions of surfaces that are 

unsuitable materials to be used as fill, for example.  These can be defined  
     as boundaries of defining features or by station limits to a defined depth(s). 
b. The Classifications item would List surface components of unsuitable 

materials or itemizing sub surface features.   
c. The Compaction/Expansion factors are provided by the Geotechnical 

engineering studies and can be used to better define volumes. 
d. The Forced Balance is set up to or between stations. A balance factor is 

calculated between stations where forced balance is applied. The balance 
factor is the accumulated fill divided by the accumulated cut up to the 
given station. If the forced balance is applied to cut, the adjusted cut 
volumes up to that station are multiplied by the balance factor. If the 
forced balance is applied to fill, the adjusted fill volumes up to that station 
are divided by the balance factor. At the forced balance stations, the 
accumulated cut and fill are reset to zero. 

 
e. The Annotation item is used to define the cross section automatic 

annotation of volume displays. The user can define custom fills for cut and 
fill shapes shown in the cross sections and annotate them. The style and 
look of the annotations can be modified to make the information more 
readable. 

 
Select the Apply button to produce the volume report. You should have 
previously set the format readout for cubic feet or cubic yards and selected the 
create XML report.  If a default end area report style sheet has not be selected 
prior to running the volume report, a dialog will send notification of the need to 
select the report style sheet and provide the dialog to choose the report form. 
 

Figure 3 
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Step 3 Select the Report 
 

 
Figure 4 
 
Figure 4 shows the dialog to choose the default report format. Right click on the 
report desired and select it as the default. 
 
Finally the report will be generated.  
 
Triangulated Volume Calculation Method 
 
Step1 Open the Volumes menu and select Triangle Volume. 
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Figure 5 
 
The Triangle Volume dialog provides pull-downs to select the Original and 
Design Surfaces. Once the two surfaces have been chosen, select the Add 
button. The Cut and or Fill Factors can also be defined. 
The Mode of calculation is most commonly Entire Surface as shown in Figure 5, 
but a fence or shapes can also be used to define the area to be calculated in the 
volume computation. 
The difference between the surfaces is defined vertically.  In other words if the 
design surface covers an area less than that of the existing surface then the 
vertical difference in the limits of the smaller area will be calculated. 
 
Step 2.  Produce the Volume Report 
Select Apply from the upper right of the Triangle Volume dialog. The message 
that was displayed in figure 3 will display unless you have already selected the 
default Triangle Volume report you want to use as the default report form. 
Once define, the report will appear. 
 
Both End Area and Triangle report are displayed in XML format and can be 
saved as the same or to HTML file types.  HTML report can be redisplay in any 
web page later for review. The save as dialog will allow you to save the report(s) 
to the project area in Project Wise for future reference. 
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Referencing  Microstation files is a standard occurrence in our preparation of 
project design documents.  We use a sheet file/model file environment which 
make referencing mandatory.  There are however some procedures that may not 
be clearly understood by all CADD users.  Below are procedures and depictions 
of dialogs and setting useful in using the Microstation referencing tools. 
 
There are two basic categories of referencing workflows with Microstation, 
design file and raster file referencing.  These referencing procedures are only 
similar in that they both are attached to the active design file though a 
referencing dialog.  

• Design reference files are files that are the same or similar in format to 
Microstation design files and can be attached coincident to the active file 
or placed interactively in any location the user chooses. This type of 
reference can be AutoCAD or Microstation design files. 

• Raster reference files are files that are rasterized or an organized group 
of pixels that represent an image of the subject.  This type can be a 
photograph, a scan of a document, or a PDF file, for example.  

 
The workflows below describe the process of referencing both design and raster 
files. 
 
Method 1.  Referencing Design Files: 
Step 1:  

• Start Microstation and open a dgn or a dwg file.  Determine whether the 
active file contains an actual geospatial coordinate location.  

• Locate the dgn or dwg file that will be attached to the active design file.  
Open the References from the main Microstation pull-down menu. You will 
see the dialog shown here.  There are associated icons for each reference 
menu pull-down item.  Take the time to familiarize yourself with these icon 
as they may improve you production time using the reference tool in both 
attaching referencing and performing maintenance work on the files such 
as clipping boundaries, moving, rotating, masking, and detaching to name 
a few tools available. 

 
Step 2:  From the pull-down menu, select Tools>Attach or from the first 
listed icon, select Attach reference file. This will take you to a browse 
window. Because we perform design work in Project Wise, you will see the 
Project Wise window appear.  

• Browse to the appropriate folder and select the file to attach as shown 
in the dialog below. 
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Once the project folder and file 
have been selected and added to 
the selected documents as show 
here. Select the OK button. 
 
 

 
 
Step 3.  Select the Reference Attachment Settings. 
The Reference Attachment Settings will be displayed. See Reference Attachment 
Settings above.   Note the top of the dialog displays the folder and file name to 
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be attached as well as  the Logical Name field.  It is critical that the user 
populates this field.  

• Use IPLOT to produce project document plot sets. Successful and 
quality presentations will rely upon the reference file logical name to 
produce tailored plots results.  For example, survey site files that are 
required to be screened or faded in appearance, will be accomplished 
by calling the logical name for every referenced instance of that survey 
site plan file.  This is done through IPLOT Pen Tables.   

o Next notice the Orientation field in the reference dialog box.  In 
the example Coincident-World is selected to insure that the 
active and the reference files are coincident with each other 
geospatially. 

o If for example, you were referencing a Title Block, detail or 
section to the sheet file you would select a Standard View or a 
Saved View from the Orientation window.  Then you would be 
required to actually place the reference location in the active file. 
In this case you would want to consider the scale factors shown 
in the field of the same name. 

o Next turn your focus to the lower portion of the dialog.  You will 
notice fields for Nested Attachments, Display Overrides, New 
Level Display, and Global LineStyle Scale.   

o Nested Attachments determine whether you choose to see 
referenced files that are attached to the file(s) you are attaching 
to the active design file. The nested level regresses further with 
the higher nested level numbers chosen.   

o Display Overrides allow the reference files level override 
definitions to be retained in the reference attachment.  

o The New Level Display is a variable that allows the reference 
to display its own levels in the level manager.  

o Global LineStyle Scale provides the choice to retain the 
reference linestyle settings or adopt the master file’s settings or 
to honor the settings in each file. 

Once the settings are selected as required, select OK to attach the 
reference to the active file.  
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The figure shown 
below has been attached with Coincident World attachment selected. The File is 
attached in the active blank file as shown below.  The referenced file is shown 
below listed in the dialog.  From this point the boundaries of the file can be 
clipped, the file can be scaled, levels can be manipulated, etc. 
Notice that the logical name given at attachment time shows up now in the 
dialog.   
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Step 4.  Select Reference Tools to modify the reference attachment. Below 
are described additional reference file manipulation tools. Refer to the figure 
above shown with the tool menu item opened. 
• The Exchange option is highlighted.  This option will check out the active 

referenced file and open it as the current design file. This will allow for some 
minor design file changes noted after the file is attached.  Once changes are 
made, opening the previous file will allow for the check-in of the “exchanged” 
file and the sheet file will then present the changes made to the reference file. 

• Open in New Session will open the selected reference file an new instance 
of Microstation and allow for edits also. This will not prompt for check in of the 
current file. Therefore,  once changes are made, the original reference file 
attachment will require refreshing in order to see the updated changes. 

• Merge Into Master will actually copy all of the reference file elements into the 
master file and then detach the that reference file.  Note: DO NOT copy 
model file elements into the sheet file.  Model file and sheet file elements 
must be kept separate. 

 
Other items in this dialog are fairly obvious as to operation and similar to the 
active file Microstation> manipulate element tools 
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• The dialog above shows the Settings Menu. First we will discuss the 
Attachment menu option.  The Attachment option shows a dialog almost 

the same as the original 
attachment dialog but with 
+the additions of the 
attachment manipulation 
settings shown at the bottom 
of the dialog as set during 
attachment either by default 
or specifically by the user.  
The settings can be changed 
in this dialog and changes will 
be evident in the live 
attachment immediately. 
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The next option is the Update Sequence. The update sequence allow the 
reording of the display of the active and  reference files.  This can be useful if 
there are element that the user requires to be displayed above other elements to 
improve readability. 
Next the Adjust Colors option is shown.  The user can readjust the reference 
color display to improve displayed elements or the plotted display when plotting 
in color.  The color table display is show that will allow each color to be redefined 
See the example below.  
 

This can be a very powerful tool when producing 
presentations for projects. However this is not of 
much value when producing contract documents 
that are plotted with black vectors and text. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Next the Highlight option allow you to highlight the boundary or the entire 
reference file or not highlight at all.  You may find it convenient to turn on the 
boundary option to see the selected reference boundary for you awareness if for 
no other reason. The remaining options are self explanatory. 
 
 
 
Referencing Raster Files 
Option 1 Geo-referencing Imagery 
Step 1.  
Open Microstation in a file which will contain the desired raster attachment. 
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Select from the Microstation File menu Raster Manager.  This will open the 
reference dialog as show below.  Note the similarity to the Design Reference 
Dialog. 
 
 
 
 

 
 
 Step 2. Adjust the raster view  
 
Like the Reference Manager, the Raster Manager can manipulate raster files 
performing functions such as rotate, scale, clip boundary, clip mask, etc.  The 
display can be modified in additional ways however such as adjusting the gamma 
(brighter or darker) changing contrast, etc.  Gamma adjustments to brighten the 
raster image that in effect washes out the image make design files text and 
vectors much easier to read. A standard gamma adjustments is 3.0.  This will 
allow both gray scale and color plots to be satisfactory in presentation for 
readability. 
 
Step 3. Check Geo-position of raster file. Many raster files are accompanied 
by World files.  World files are text files that define the pixel size, resolution,  and 
position of the origin point and is commonly expressed in XY coordinates. If 
Microstation raster preferences are set correctly the world file should correctly 
position and scale the raster image in the design file. Other raster files come from 
the sources with location, resolution, and scale information contained in the 
header of the raster file.   
Occasionally even though a world file or sister files accompanies the raster the 
location is still incorrect.  Most common faults are incorrect Microstation raster 
manager preference settings. If the following procedure proves unsuccessful call 
the CADD Coordinator. 
Some raster types use differing points of origin.  JPEG and TIFF files, for 
example locate the origin at the lower left corner of the lower left pixel.  SID files 
use the center of the upper left pixel as the origin.  The file type is important in 
beginning to modify positions of files. 
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1. Select Attach from the File menu pull-down the raster file  

 
2. Double-click the desired reference file to display the attachment settings 
dialog as shown below.  

 
 
 
 
 

 
 
Step 3 Set the Geometry location and Display 
Two of the most important raster reference setting dialog displays are shown 
above. On the left you see the Origin settings and Pixel Size fields.  A quick 
sanity check can tell the designer if the location (state plane coordinates) are 
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reasonable. If for example the file was displaying coordinate that are much 
greater than reasonable (perhaps a metric coordinate), check the coordinate by 
dividing the number by 3.2805. If the resulting figure is in keeping with the actual 
location of the site, then the field displaying the X and Y can be repaired by 
placing a forward slash ( / ) after the each field X and Y, and then entering 
3.2805. This will in effect reduce the entries by dividing by 3.2805 correcting the 
entry. 
The pixel size is also located below the origin that will display a single pixel 
dimension in the example the dimension is 3.2805 which means that the 
resolution is 1 meter.  On the right you see the Display Print fields.  For most 
aerial photography a print gamma of 3.0 is sufficient. This setting will lighten up 
the image to allow black vectors and text to contrast against the background of 
the photo image. 
 
Step 4.  Warp raster images to fit a dgn file plan.  Imagery that has no 
geospatial positioning but does correspond to an existing  site plan for instance 
can be resized and/or stretched to fit the site plan.  To perform this stretching or 
Warping of the image, first identify a number of points common to both the 
image and the dgn site plan. For example choose building corners, street 
intersections, survey bench marks shown on both the dgn as well as the image 
file.  Six or more points are preferred in order to make an accurate fit of the raster 
on the dgn file.   
NOTE: If warping points are close together the area in and around will be more 
accurate but the further away from the position points the greater the 
inaccuracies will be. It is like  
 
 
stretching a  rubber sheet from the middle; the outside of the sheet is not much 
affected by the internal warping of the sheet. 
 
The different methods of warping are Affine, Similitude, and Align. To warp an 

image to alignment with a  geospatial 
design file, choose Affine from the Warp 
Raster dialog. The routine will ask you 
to choose image points to match with 
the dgn points. Once choose points 
routine is complete, select  the reset or 

right mouse button and the raster image will be redisplayed in its new position. 
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Similitude is similar to the Affine method of warping except the similitude method 
can use as little as two points where the Affine method must have a minimum of 
3 points.  The Align method is just used for resizing and aligning  to another 
object. 
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True Type Format Implementation Effective Date  
All new project starts shall use True Type fonts for all text usages in project 
documents.  (See the matrix below for the application of fonts.)   

July 20, 2009 

 
Who is required to use the new format? In-house project teams, 
Districts brokering project design documents, AE design firms, and survey 
contract firms. 
 
Resource locations: All project resources are provided in order to implement 
the True Type fonts.  These resources include Borders, Cover Sheets, Index 
Sheets, Location and Vicinity Map files, Companion Cell Library, CADconform 
files, and DGNLIBs.   Project Wise contains all resources for in-house users.  
The District CAD Resources WEB page contains all resources for outside 
contributors to project production. 
 
Resource Definitions: 
Cover Sheet, Borders, Index sheet, Location and Vicinity Map files 
(including the Optional Index file) These files are not significantly different 
except for the use of True Type fonts (Arial and Arial Black).  The exception is 
the Index and Optional Location and Vicinity Map.  The format for these files has 
been edited to reduce the redundancy of project information shown on the cover 
sheet.  The optional location and vicinity map file incorporates a single column 
index for small projects that contain a small number of sheets but also has room 
for the location and vicinity maps as well. 
 
Companion Cell Library: The companion cell library contains all of the elements 
from the Border Companion DGN file formally used but has been converted to 
graphic cells and text conforms to the True Type format.  Any of these graphic 
cells inserted into a design file will assume the current level and attribution 
assigned to the active level. A text cell can be placed and used to expand the 
text included or use it as a tool for matching text attributes.   
 
CADconform files: CADconform and its resources are controlled by a set of 
databases (one for each discipline).  These databases and attached tables 
define the drafting tools and compliance checking tools. These databases have 
been modified to include the True Type font definitions. 
 
1

                                                 
1 Corps of Engineers only. 

DGNLIBs: DGNLIBs are design files that may include Levels for each discipline, 
Text Styles and Dimension Styles. These DGNLIBs set file formatting for users 
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through the application of the Project Wise Workspace. The DGNLIBs for Text 
Styles and Dimension Styles are also configured with True Type fonts.  The 
Jacksonville District Project Wise Workspace provides the resources for all of the 
resources listed in the definitions included here. 
 
Using True Type Fonts: 

1. All design file text will be prepared using the specified True Type (TT) 
fonts as listed in the table  below:  (Text sizes are calculated by multiplying 
the  base text size by the Plot Scale (P.S.) 

   
Text Usage True Type Font Text Size X P.S. 
Cover Sheets  
Contains a mix of: 

ARIAL BLACK & 
ARIAL Varies (edit text in 

cover sheet) 
Index Sheet Title Text  ARIAL BLACK Text in sheet 

provided 
Index Sheet Drawing 
Listings 

ARIAL .01 X P.S. 

Title Block Project Title Text  
Title Block Sheet Title Text 

ARIAL BLACK 
 

.0146XP.S. 

.0116XP.S. 
Title Block Drawing No. 
Block Text 

ARIAL BLACK .3XP.S. 

General Text ARIAL  .01XP.S. 
Sheet and Model files: 
Headings and Subtitles 
such as PLAN or Section 

ARIAL BLACK .0116XP.S. 

Sheet and Model files: 
Notes with leaders and 
dimensions 

ARIAL .01XP.S. 

Sheet and Model files: 
Stacked or Columnar text 
(schedules, general 
numbered sheet notes) 

ARIAL .01XP.S. 

Hydrologic text (flow 
indicators, slope symbol 
text).  

ARIAL W/22 
DEGREE SLANT. 

.01XP.S. 

Water Body Labels, Cut 
Lables 

Arial Black w/22  
DEGREE SLANT 

.0146XP.S. 

Range Text, Channel 
Station Text, Water Elev. 
Text 

ARIAL With 22 
Degree Slant 

.0116XP.S. 
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2. The Project Wise Workspace is configured to utilize Cover Sheets, Index 
Sheets, General Information Sheets,  DGNLIBs and Companion Cells with 
the True Type fonts set  correctly for your use. 

a. Users can use the Match Text tool to set the font attributes from the 
companion cell attached or copy text into the current design as is 
done currently.  

b. No mixing of Bentley fonts and TT fonts is allowed.   
c. Some legacy files used as references will require converting to 

True Type fonts.  Contact the CADD Coordinator for help. 
3. CADconform databases have been updated to define TT font usage for all 

disciplines. 
4. The InRoads XIN Configuration file has been updated to define TT font 

usage for all named symbology annotation texts. 
5. For any usage not already set up for TT fonts, Use the table below as a 

cross-walk to define which TT font  is defined to replace existing Bentley 
or legacy Corps fonts. 

 
Legacy or Bentley Fonts True Type Font Substitution 
Corp Font #8 Arial 
Corp Font #9 Arial 22 degree slant 
Corp Font #10 Arial 
Corp Font Corp Bold ARIAL BLACK 
Bentley Low Resolution Filled ARIAL BLACK 
Bentley Compressed ARIAL BLACK 
Bentley Engineering Arial 
Bentley Working Arial 
Bentley #23 Italics Arial 22 degree slant 
 
6. When replacing legacy font for use in sheet files and model files, be sure 

to turn on the use of fractions and slanted text where appropriate. 
 
 
 

Text Style Usage 
Using Text Styles will take the complication out of design file development.  
Below you can see the Text Styles created in the Text and Dimension Style DGN 
Library delivered to all Project Wise folders and files with a Standard Workspace 
attached. 
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Above is a listing shown of all current Text Styles. These styles are named for 
the category of text usage that may be needed. Each also has specific settings 
that include a font name, base text height and width, slant angle if any, 
justification, line spacing, underlining if required, and background block-out. The 
explanation below explains these settings. 
Note: there are more style shown in the dialog above that are listed in below in 
example tables. The tables below are for explanation purposes only and are not 
all-inclusive. 
Font: New Designs require only two fonts Arial and Arial Black.  
Text Height and Width: Text height and width is set at a base value that will be 
multiplied by a scale factor.  For text notes that would be plotted at a plot scale of 
1/4”=1’ , a scale factor of 48 would be used to multiply the base text height. 
Notation text that has a base text height of .01 multiplied by 48 will result in a text 
height of 0’ 6”.  Each text style has a base text height relative to the scale factors 
that will be incorporated in the drawing being developed. 
Slant Angle: Text used to describe hydrographic features such as channel 
names, cut labels, water body titles, flow directions, range mark annotations, 
soundings, etc. 
Justification: All efforts have been made to establish a best fit for the 
justification for each style based on the most common use.  It is possible that the 
user may need to modify the justification for abnormal situations. 
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Line Spacing: Standard line spacing  of ½ the text height has been used in all 
styles. 
Underlining:  Text underlining has been activated for all styles where an 
underline is preferred including Cut Label, Sub-Title, and Main-Title text 
placements. 
Background Block-out: Most text styles have been set-up to block-out 
interfering background graphic elements with the default background color.  This 
will not plot, but will eliminate the need for clipping or deleting elements which 
interfere with notes or text placed in the design file.  
Each Text Style activates the Annotation Scale Lock that will control the text 
attributes of the same text style based on the scale factor set. For example, if the 
drawing scale is changed, the text size will change as well. 
Note: If in a 3d file, you must reset the active Z (elevation) to an elevation 
above the other elements in the file over which the new text will be placed 
or the background blocking will not be successful. 
 
Drawing Scale The drawing scale tool is a companion tool to text usage and is 
used to set the intended scale for each drawing.  The drawing scale tool can be 
activated from the Settings menu in Microstation. The tool (shown below) can be 
set to the intended plot scale after activation of the Annotation Scale Lock as 
show below by the darkened icon containing the red “A”. Select the scale pull-
down to the right of the annotation scale lock.  When using the workspace 
configuration the user will be able to access any needed scale. 

 
 
Finally, when the Text Styles and Drawing Scale tools are used in conjunction 
with one another the scale-based text-size calculation process can be eliminated 
for the user. 
Older Projects:  Project started prior to June of 2009 require the use of Bentley 
Fonts.  Projects in this category should have workspaces set up that will make 
use of text styles as defined in the workspace implemented before True Type 
Text implementation.  Call the SAJ CADD Coordinator for further details if 
needed. 
 

Text Style Workflow. 
 



Appendix B-7 
Plans Preparation Manual 

  True Type Text User Guide 
 

USACE 
Page - 6 - of 7 

Project files being developed should be contained only in a Project Wise 
directory for Corps of Engineer users; AE firms should have a workspace setup 
that make use of the DGNLIBs much the same way as described above2

 

.  In this 
way a workspace configuration can be assigned that will provide the user the 
needed resources such as Text Styles that are discussed below. 

The workspace attaches a DGNLIB that provides text styles. Previous 
documents have been distributed that introduced True Type fonts and text styles 
that were initially set up, as well as a procedure for use of the drawing scales.  
These tools work in conjunction with one another. See the workflow below. 
 
Step 1.  Open the Drawing Scale tool.  From the main menu select: Settings> 
Drawing Scale. The Drawing scale tool will open (the dialog can be docked at the 
top or bottom of your screen).  
 Next: Select the Annotation Scale Lock icon.  
 Next: Select the scale to which you will be plotting. This sets the  
scale factor that multiplies base text settings by the scale factor to generate a 
“real-world’  text heights based on the style being used.  
 
Step 2.   Select the appropriate text style from the list provided.  The styles 
are arranged in categories of usage. See list below. 
The examples below assume a drawing scale setting of 1”=100’ (scale factor 
1200:1) 
 
 

Style Name Font Name Scale Factor Text Height 
Channel Cut, 
and Water Body 
labels  
 

Arial Black  
(slanted 22°) 

1200:1 17.5 ‘ 

Channel Range 
text 
 

Arial (slanted 22°) 1200:1 14’ 

Match Line text Arial (bold) 1200:1 14’ 
Dimension 
 

Arial 1200:1 12’ 

Drawing No.  
(Title block) 
 

Arial Black 1200:1 30’ 

General Text 
and Schedules 

Arial 1200:1 12’ 

                                                 
2 See Workspace Readme file from downloaded from the SAJ website. 
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Headings and 
Stationing text 
 

Arial 1200:1 14’ 

Main Subject 
Title 
 

Arial Black 1200:1 20’ 

Notes (Multi-line 
& Leader) 
 

Arial 1200:1 12’ 

Slanted Notes 
 

Arial 1200:1 12’ 

Sub-Title 
(Sections-
Details-Plan) 

Arial Black 1200:1 17.5 

Symbology  Symbol 1200:1 12’ 

          
The user must only set the scale from the drawing scale tool and then select 
the text style based on the category of use. The text height is automatically set.
           
   

 
Note: If opening an existing drawing or referencing an older drawing where other 
Text Styles have been used, the user may see additional text styles in the Text 
Styles dialog that do not comply with the required format.   
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Purpose: The purpose of this Appendix item is to describe the use and 
management of Microstation Levels. 
 
Definitions: 
Levels: Microstation uses the term Level; AutoCad uses Layer. Levels are used 
to segregate drawing elements into manageable groups within a DGN file. 
Level Attributes: Microstation Levels have element assignment attributes such 
as color, weight, line style, level locks, plot/no plot settings, level display settings, 
etc. 
Level Overrides: Level Overrides allow the user to change the appearance of 
elements on levels by setting color, weight, line style to settings different than 
those set in the by-level settings in the Level Manager.  
LS: Line Style definition 
CO: Element Color assignment 
WT: Element Weight  assignment 
DGNLIB: Design File Library  The DGNLIB assigned by a workspace predefines 
the level names and attributes when attached to the active design file. The levels 
assigned by the DGNLIB contains the attributes prescribed by the AEC CADD 
Standard. 
 
Microstation Levels and Attributes. 
Microstation V8 Levels have a format that differs greatly from Microstation V7.  
Microstation V8 have the ability to attach definitions of Names, color, weight, and 
style of elements created or assigned to each level.  In addition each attribute 
can be locked to force each of the three level primary attributes to the settings 
set in the level manager. For example, the level for channel toes (C-CHAN-
TOE~) has settings of Color= 1, line style=3, weight=3.  If each of these level 
attributes are set to Bi-Level, then when the level is set to current or active and 
an element is created in the design file, the attributes will be assigned to the 
elements.  By the same token, when one of these attributes are changed then 
the color, line style, or element weight will also change in the existing elements 
that were created with the by-level lock on. 
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Elements Controlled by By-Level Lock. 
Elements assigned to each level can be assigned a “bylevel” setting. This means 
that elements place in the design file will be forced to inherit the attributes 
assigned in the level manager. In so doing, existing levels placed previously in 
the file will inherit the colors, weights or styles assigned by the By-level lock.  To 
lock this ByLevel setting use the cursor to select either of the color, weight or 
style from the primary attributes tool bar and find the by-level option in either of 
these dialogs and select it. This will set the by-level setting lock. (see example 
below) 

  
 
Changing Level Attribution. 
Level attributes are assigned in the Level Manager as delivered by the DGNLIB 
The assignments are defined in the AEC CADD Standard. The preparation of 
project plans can require the modification of existing Color, Weight or Line Style 
in order to differentiate existing elements from design elements for example. The 
attribute can be changed in the local file, (as shown below in the level manager), 
however, this practice will invoke errors in the compliance review process during 
submittal periods.  If changes are needed to be made, defining Level Overrides 
is the accepted practice as described in Setting Up Level Overrides.   
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Setting Up Level Overrides. 
 
Changing level attributes  by using level overrides is a preferred method because 
you can change the appearance of level attributes without actually changing the 
by-level attribute assignments. See the image to the level overrides dialog below. 
 

 
 
Notice the properties menu item above is highlighted. This is found by right-
clicking the mouse (reset) button and selecting Properties. See the resulting 
Properties dialog below. 
Notice the lower portion of the properties dialog entitled Symbology Overrides. 
The color, style, weight, or material can be changed. The changes will affect the 
dgn elements’ appearance for the specific level for which element overrides have 
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been assigned. However the View Attributes (below-right) must have the Level 
Overrides selection must be activated.  A caveat to using Level Overrides is that 
when activating Level Overrides will display all override settings which have been 
defined or turned on in the properties of each level in the design file levels.  All 
efforts have been made to turn off level overrides in the DGNLIBs that have been 
provided in the SAJ Workspace.  
 
 

 
 

Note in the partial dialog on right that 
the style and weight have been 
changed as might be desired to show 
elements that represent existing items 
when the segregating new from 
existing is desired. 
Remember level overrides and view 
attributes are companion dialogs that  
require coordination.   
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New Workflows require the use of Annotation Scale Lock to be set.  This enables the 
use of the required Drawing Scale Tool and Text Styles and Line Style scaling.  The 
workflow for the Annotation Scale Lock, Text Styles, and Drawing Scale is described 
in Appendix B-7.  Line Styles are also integral to the proper presentation and drafting 
quality standard requirements and are controlled by the Annotation Scale Lock.  The 
description and workflow below explains the proper use of these tools in association 
with the line style usage. 
 
New Drawings created and developed in a properly configured workspace such as the 
Jacksonville District’s workspace will provide the attachment of the Text and 
Dimension style library (USACE-Dim-TextstylesTT.dgnlib) file and the AEC Standard 
Line Style resource file (tsaec.rsc). These two resources will provide the user with the 
proper text styles and line styles needed for standard compliance design products. 
 
Standard line styles are scaled based upon the CADD Scale factor. For example a 
intended plot scale of 1” = 10’ would result in a scale factor of 120. Applying that scale 
factor to the linestyle will properly size the components of the line style. If the line style 
is a under ground electric utility and is represented by a “E-ux” text symbol inserted in 
the line, the correct line style will size the line style symbols (and text) appropriately.  
 
WORKFLOW: 
NEW DRAWINGS: 
Assumptions: A workspace is configured attaching the Text and Dimension DGNLIB 
file and the AEC Line Style Resource file. 
Step 1. Open the Drawing Scale Tool. The tool is found under the Microstation 
Settings Main Menu item. Once the Drawing Scale tool is opened, It may be docked at 
the top or bottom of  

the design window. 
 
 
 

a. Activate the Red “A” icon 
in the Drawing Scale tool. This 
will allow the drawing scale to be 
set to the intended plot scale and 
also sets the Annotation Scale 

lock. 
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b. With the Annotation Scale Lock activated, Text size and line 
style scale will be automatically set or sized appropriate to the scale 
factor as seen at left. 

c. The AEC Standard Levels have colors, weights and line styles 
assigned as bylevel attributes. See Appendix B-8 Level Attributes 
and Level Overrides. A properly configured Workspace will 
automatically set the proper level library and the line style resource 
files. The AEC Levels Standard includes assignments of line styles 
for each level.  Each line style’s appearance is controlled by the 
Drawing Scale and Annotation Scale Lock. Line style scales are 
automatically sized by the drawing scale factor. 

 
 

Step 2. Verify Active Model Properties 
Open the Model dialog by selecting the blue box-shaped icon on the Primary Tools 
palette. 
The Primary tools dialog is shown below and contains the Models icon and tool dialog 
(as shown below). 
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From the models dialog select the properties option from the Properties icon as 
indicated showing the highlighted icon below.  
This will display the Model Properties dialog.  In the middle portion of the dialog you 
will see the Line Style Scale: field. This field has a pull-down with both “Global Line 

Style Scale” and “Annotation Scale” options. Always select the Annotation Scale 
option. This setting will automatically be set in all seed files and dgnlib files. Using this 
option will scale placed line styles appropriately according to the scale factor used. 
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Note that the Drawing Scale is set to 1”=40’’ which equates to a scale factor of 480. 
The scale factor is the value that increases the line style to the proper size. 
 
Remember that using the Annotation Scale Lock, Drawing Scale tool, Text Styles, 
Dimension Styles, and Line Style scaled with annotation scale lock is mandatory for all 
COE users and those preparing designs for the Jacksonville District.  
 
 
WORKING WITH EXISTING DRAWINGS: 
 
Existing design files are most often used in the reference file mode. Being able to 
control the scale of line styles however is still necessary due to the requirements to 
utilize annotation scale lock and drawing scales to size text, dimensions, and line 
styles. Existing files must be opened and existing line styles must have the line style 
scale turned off. This will allow the Annotation Scale Lock to work in conjunction with 
the Drawing scale or Active Scale (AS) to properly size text, dimensions and line 
styles. This is a editing process that is accomplished by following the steps below. 
 
 
Step 1. Open the Active Model dialog in the existing file. 

a. Open the properties of the active file model dialog. Note: If the existing file is a 
survey file, someone in Geomatics will have to edit the file and make needed 
changes. 

b. Change the Line Style Scale field from Global Line Style Scale to Annotation 
Scale. See the dialog describing the new file procedures for the view of the 
Model dialog and Model Properties dialog. 

 
Step 2. Turn off the Line Style Scale.  

a. Open the Microstation Elements Menu Item and select the Line Styles menu 
item and then Custom.  This will display the line style definition and a Line Style 
Scale: field. Edit the field to read 1.0000.  Uncheck the  Line Style Scale: item. 

Step 3. Identify the custom line styles to be rescaled. 
a. Lines that are needed to be rescaled in active files to differing scales such as 

lines containing codes or text that will appear much larger than normal and 
affect the presentation quality are candidates to modify. 

b. Activate the Element Information  tool and select the line style element. This will 
display the properties of the line as seen below. Note that the Extended section 
of the Element Info shows a line style scale of 480 (a 1”=40’ scale factor) .  This 
field will have to be modified to a scale of 1. See the screen capture below. 
Repeat the process for each line style that need to be modified. Note: the in this 
case the Line Style Scale was already set to 480 so if the drawing scale (or 
Active Scale) is also set to 480 then the one will be multiplied by the other 
resulting in an huge scale.  

c. Be sure to save the settings of the design file before exiting the drawing.      
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Note: The two dialogs below shows the before and after state of needed field 
entry changes. 
                                                                                      
 
 
 
 

 
 
 
 
 
 
 
 
 
 
  
 



Appendix C 
Plans Preparation Manual 

CadConform Report Generator Guide 
 

USACE 
 

The CadConform® Report Generator Guide  
The Report Generator is describe below in the excerpt from AltivaSoft Inc Cadconform 
Guide Chapter 3.  This excerpt has been reproduced by permission and intended for use 
by Corps of Engineers personnel only in conjunction with license agreements that apply. 



T H E  R E P O R T  G E N E R A T O R  
 

Chapter 

3 
The Report Generator 
Generating Reports 

G E N E R A T I N G  R E P O R T S  

The Report Generator is used to create reports on a list of design files that do or do not match 
any of the features in the chosen Feature Tables. The Report is generated as a database table, 
either in the CADconform database, or in a separately chosen ODBC data source (as defined by 
the user). This database table can then be printed out, converted to a text file or other file format. 

Note:  To run repor s, the user must be logged into CADconform and the user must be 
granted the privileges from the CADconform Administrator to create reports.  The 
Administrator can lock the user into a “reporting only” database. 

t

To start the Report Generator, from the CADconform Toolbox, click on the Generate Report 
icon. 

 

 

 

Figure 29:  Starting the Report Generator 

If no Feature Tables have been selected, the Feature Table Manager will open. Highlight the 
necessary Feature Tables to generate the reports and then click Open. 
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Figure 30:  Selecting Feature Tables for Report Generation 

After selecting the Feature Tables and clicking on Open, the Report Generator opens. 

 

 

 

 

 

 

 

 

 

 

 

 

         Figure 31:  The Report Generator 

There are several options available to the user to configure the Report Generator as to what files 
Reports will be generated for and what information will be included in the reports.  Reports can 
be generated for multiple design files and the Report Generator can search for and report on 
Reference Files. Reports can be generated for specific levels within the design file.  In the case of 
Reference Files, the user has the option to generate reports only for the clipped portion of the 
Reference File or the entire Reference File. 
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S I N G L E  F I L E  R E P O R T  

To run a report you must first type in a report name.  Do not use special characters other than 
underbars in the Report Name field.  Toggle checkmarks adjacent to the type of report to be 
run. In the example below, an Error Summary and an Error List Report are to be run.  Click the 
Report button to generate the report. 

Note:  The user will be warned if a report name exists. The user will have the option to 
overwri e or delete a report if he is either the original owner o  the report or has been 
granted the privileges to do so by the CADconform Administrator. 

 
t f

 

 

 

 

 

 

 

 

 

 

 

 

Figure 32:  Creating Report Name Rpt4_10_08 

 

 

 

 

Figure 33:   Report Progress Status 
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       Figure 34:   Report Summary 

M U L T I P L E  F I L E  R E P O R T  

To run a report on multiple files, the user must first select the files.  This can be accomplished one 
of two different ways. 

 

 

 

 

 

 

 

 

 

    Figure 35: Select DGNs                   Figure 36:  Select Design Files 

Either of the above options will open the Design Files to Process dialog box. 
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Figure 37: Select the Files and click on Add 

Highlight the files to be selected and click on Add.  The selected files are added to the Current 
List box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 38:  Current List box Populated 

Once the files have been selected, click the Done button. 
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Note:  Each file in the Current List box will be opened as it is processed. You will see the 
opening and closing of each design file on your screen. At the completion of the process, 
the las  file opened will remain as your active design file until you reopen the original file. t

 

 

 

 

 

 

 

 

Figure 39:  Report Summary from Multiple Files 
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Chapter 

4 
The Report Viewer 
Viewing the Reports 

The Report Viewer allows a simple way for the user to view the contents of a report without 
resorting to opening the database from within a database application. This is particularly 
advantageous for users who do not have a database application loaded on their machine. 

The Report Viewer also provides a method of interactively reviewing errors in the report, and 
exporting reports to text files or comma separated value files (CSV) for importing into 
Spreadsheet applications such as Microsoft Excel. 

U T I L I Z I N G  T H E  R E P O R T  V I E W E R  

After running reports using the CADconform Report Generator, the user clicks on the View 
Report button to open the Report Viewer. 

 

 

 

 

 

 

 

 

 

 

 

 

           Figure 40:  Viewing the Report 
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                 Figure 41:  Report Viewer 

The Report Viewer dialog and its columns are fully resizable.  To view an error summary, toggle 
on the Error Summary radio button by clicking on it.   This will cause the Report Viewer to list a 
summary of the error types and the number of errors for the particular error type. 

        Figure 42:  Error Summary 
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A nice feature of the Report Viewer is that if information in a specific column is truncated due to 
the column width, the user does not have to adjust the column width to see the entire 
information. By holding the mouse over a truncated column, the entire information for that 
specific row in that column will be displayed as shown below. 

 
    Figure 43:   Expanded column width 

The Error List lists each error in the design file. It also lists the location of the error within the 
design file and has intelligence tied to the report such that double clicking on the error in the 
report will locate the error in the design file. In the case of error reports for multiple design files, 
the file containing the error will open to display the error. 

Figure 44:  Error List 

Double clicking on the line in blue above will take me to the location of the text error shown in 
this report. 

 

 

 

 

Figure 45:  Location of error 
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V I E W I N G  T H E  R E P O R T S  
 

E X P O R T I N G  T H E  R E P O R T  T O  A  T E X T  F I L E  

Reports generated by CADconform can be exported to a text file by simply clicking on File then 
Export. 

 

 

 

 

 

 

 

                 Figure 46:  Exporting Report 

 

 

 

 

 

 

 

 

 

          Figure 47:  Exporting Report 

 

           Figure 48:    Sample Report exported text file
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